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 Padasalai's NEWS - Group  

https://t.me/joinchat/NIfCqVRBNj9hhV4wu6_NqA 

 

 Padasalai's Channel - Group 

https://t.me/padasalaichannel 

 

 Lesson Plan - Group 

https://t.me/joinchat/NIfCqVWwo5iL-21gpzrXLw 

 

 

 12th Standard - Group 

https://t.me/Padasalai_12th 

 

 11th Standard - Group 

https://t.me/Padasalai_11th 

 

 10th Standard - Group 

https://t.me/Padasalai_10th 

 

 9th Standard - Group 

https://t.me/Padasalai_9th 

 

 6th to 8th Standard - Group 

https://t.me/Padasalai_6to8 

 

 1st to 5th Standard - Group 

https://t.me/Padasalai_1to5 

 

 TET - Group 

https://t.me/Padasalai_TET 

 

 PGTRB - Group 

https://t.me/Padasalai_PGTRB 

 

 TNPSC - Group 

https://t.me/Padasalai_TNPSC 
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Padasalai

கணினி த ொழில்நுட்பம்(12ஆம் வகுப்பு) 

பொடம் 1 

அடடொப் டபஜ்டேக்கர் 

பகு ி அ 

1. DTP என்பதன் விரிவாக்கம் அ) Desktop Publishing 
2. _________ என்பது ஒரு DTP மென்மபாருளாகும். ஆ) PageMaker 

3. எந்த பட்டியில் New கட்டளள இடம்மப ற்றுள்ள து? அ) File menu 

4. Page Maker சன்னல் திளையில் கருப்புநிற எல்ளைக்ககாட்டிற்கு 

மவளியில் இருக்கும் பகுதி ____ என அளைக்கப்ப டும்ஆ) pasteboard 

5. PageMaker ஆவணத்ளத மூடுவதற்கான விளசப்பைளக குறுக்கு 

வைி _________ஈ) Ctrl+W 

6. _________ கருவி ஆவணத்தின் ஒரு பகுதிளயப் மபரிதாக்கிப் 

பார்க்கப் பயன்படுகிறது. இ) Zoom tool 

7. மபட்டிகள் வளைவதற்குப் பயன்படும் கருவி _________இ) Rectangle 

8. Place கட்டளள _________பட்டியில் இடம்மப ற்றிருக்கும்அ) File 

9. முழு ஆவணத்ளதத் கதர்ந்மதடுக்க விளசப்பைளகயில் 

____குறுக்கு வைி சாவி கசர்ொனத்ளத அழுத்தகவண்டும்.  அ) 

Ctrl+A 

10. எழுத்து வடிவூட்டல்கீழ்க்கண்டவற்றில் எந்தபண்புகளளப் 

மபற்றிருக்கும்?   

ஈ) All of these 

11. உளைளய பதிப்பிக்க பயன்படும் கருவி எது? அ) Text tool 

12. PageMaker இல் ஆவணத்ளத அச்சிடப் பயன்படும் விளசப்பைளக 
குறுக்கு வைி _________ஆ) Ctrl +P 

13. அகடாப் கபஜ்கெக்கர் என்பது_________ மெ ன்மபாருளாகும்  
ஒரு பக்க வடிவமேப்பு 

14. _________ பட்ளட கபஜ்கெக்கர் ஆவணத்தின் கெல்பகுதியில்   
    இருக்கும்.   மை ப்புப் பட்மட (Title bar) 

15. ஆவணத்ளத கெலும் கீழுொகவும், இடது ெற்றும் வைது 

புறொகவும்    
நகர்த்துவளத _________என்கிகறா ம்.  ிமை உருளல் தெய் ல் 

(Scrolling) 

16. _________ கருவி வட்டம் வளைவதற்குப் பயன்படுகிறதுEllipse 

17. _________ பட்டிளயக் கிளிக்மசய்து Insert Pages விருப்பத்ளதப் 
மபறைாம்.Layout 

18.  அ) Cut   (iii) Ctrl+X 
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ஆ) Copy (iv) Ctrl+C 

இ) Paste(ii) Ctrl+V 

ஈ) Undo (i) Ctrl+Z 

19. கீழ்க்கண்டவற்றில் மபாருந்தாத ஒன்ளற த் கதர்ந்மத டு. 

i. Adobe PageMaker, QuarkXPress, Adoble InDesign, Audacity 

20. கீழ்க்கண்டவற்றில் சரியான கூற்ளறத் கதர்ந்மதடு. 

i. ஆ) சுட்டி ெற்றும் விளசப்பைளகயின் மூைம் உளைளயத் 

கதர்ந்மதடுக்க முடியும் 
ii. அ) DTP என்பதன் விரிவாக்க ம் Desktop publishing. 

21. கீழ்க்கண்ட வற்றில் சரியான இளணளயத் கதர்ந்மதடு. 

i. அ) Edit Cut 

ii. ஆ) Undo Redo 

பகு ி ஆ 
1. Desktop Publishing என்றால் என்ன? 

Desktop Publishing என்பது DTP மென்மபாருளள பயன்படுத்தி 
ஆவணங்களுக்கான பக்கங்களள வடிவளெப்பு மசய்வதாகும். 

2. DTP மென்மபாருள்களுக்கு எடுத்துக்காட்டுகள் தருக? 
DTP மென்மபாருள்கள் சிை அகடாப் கபஜ்கெக்கர் (Adobe 
Pagemaker), அகடாப் இன்டிளசன்(Adobe in Design), குவார்க் 
எக்ஸ்பிைஸ்(Quark Xpress) 

3. கபஜ்கெக்கர் மென்மபாருளள திறப்பதற்கான 
வைிமுளறகளளக் கூறு? 
Start-All Programs-Adobe- PageMaker7.0-Adobe PageMaker 7.0 என்பளத 
கிளிக்மசய்து திறக்க முடியும். 

4. கபஜ்கெக்கர் மென்மபாருளில் ஒரு புதிய ஆவணத்ளத 
எவ்வாறு திறக்கைாம்? 
1. File-New(அல்ைது) Ctrl+N என்பளத கிளிக் மசய். 
2. உளையாடல் மபட்டி கதான்றும். அளவுகளள உள்ளடீு மசய். 
3. OK மபாத்தாளன கிளிக் மசய் 

5. ஒட்டுபைளக என்றால் என்ன? 
 கருப்பு நிற எல்ளைக் ககாட்டிற்கு மவளியில் உள்ள பகுதி 
ஒட்டுப்பைளக எனப்படும். ஒட்டுபைளகயில் ளவக்கப்படும் எதுவும் 
அச்சிடும்கபாது வைாது. வடிவளெப்பு கருவிகளள ளவக்க 
ஒட்டுபைளகளய பயன்படுத்தைாம். 
6. கபஜ்கெக்கரில் உள்ள பட்டிப்பட்ளட பற்றிகுறிப்பு எழுதுக? 
 File,Edit,Layout,Type,Element,Utilities,View,Window,Help கபான்ற பட்டிகளள 
மகாண்டுள்ளது. பட்டிளய கிளிக் மசய்தால் துளணப்பட்டியல் 
கதான்றும். 
7. எைிப்ஸ் டூல் ெற்றும் எைிப்ஸ் ஃபிகைம்டூல் கவறுபடுத்துக? 
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எைிப்ஸ் டூல் எைிப்ஸ் ஃபிகைம்டூல் 

வட்டம்,நீள்வட்டம் வளையப் 
பயன்படுகிறது. 

உளை ெற்றும் வளைகளை 
ளவப்பதற்கான நீள்வட்டங்களள 
வளைய பயன்படுகிறது. 

8. உளை பதிப்பித்தல் என்றால் என்ன? 
 ஆவணத்தில் உளைளய கசர்த்தல்,நீக்குதல்,பிளை திருத்துதல், 
நகர்த்துதல் ெற்றும் நகல் எடுத்தல் கபான்ற மசயல்பாடுகளள 
மசய்தல் உளைபதிப்பித்தல் என்று மபயர். உளையில் ொற்றங்கள் 
மசய்தல் உளை பதிப்பித்தல் என்று மபயர். 
9. உளை மதாகுதி என்றால் என்ன? 
 உளைத் மதாகுதி என்பது நாம் தட்டச்சு மசய்த உளைளய 
அல்ைது ஒட்டிய உளைளய அல்ைது கவறுஆவணத்தில் இருந்து 
மகாண்டுவைப்பட்ட உளைளய மகாண்டிருக்கும். 
10. மதாடர்புள்ள உளைத் மதாகுதி என்றால் என்ன? 
 ஒரு உளைத் மதாகுதியில் உள்ள உளைளய ெற்மறாரு 
உளைத்மதாகுதிக்குள் மசல்லுொறு அளெக்க முடியும். ஒரு உளைத் 
மதாகுதிளய ெற்மறாரு உளைத்மதாகுதியுடன் இளணக்ககவா 
அல்ைது மதாடர்பு படுத்தகவா மசய்ய முடியும். இவ்வாறு மதாடர்பு 
படுத்தப்பட்டிருக்கும் உளைத்மதாகுதிகளுக்கு மதாடர்புள்ள 
உளைத்மதாகுதி என்று மபயர். 
11. மதாடர்புள்ள உளை என்றால் என்ன? 
 உளைத் மதாகுதகளுக்கு இளடகய உள்ள உளைளய 
இளணக்கும் மசயல்பாட்டிற்கு மதாடர்புள்ள உளை என்று மபயர். 
12. கபஜ்கெக்கரில் புதிய பக்கங்களள எவ்வாறு மசருகைாம்? 
 1. Layout-Insert Pages என்பளத கிளிக் மசய் 
 2. உளையாடல் மபட்டி கதான்றும் 
 3. Insert உளைப்மபட்டியில் கசர்க்க கவண்டிய பக்க 
எண்ணிக்ளகளய தைவும் 
 4. After (அ)Before என்பளத கதர்வு மசய் 
 5. Insert மபாத்தாளன கிளிக் மசய். 

பகு ி இ 
1. கபஜ்கெக்கர் என்றால் என்ன? அதன் பயன்களள கூறுக? 

கபஜ்கெக்கர் என்பது ஒரு பக்க வடிவளெப்பு மென்மபாருள் 
ஆகுெ. 
பயன்கள்: 

• பக்கங்களள வடிவளெக்க பயன்படுகிறது. 
• சிறிய அட்ளட முதல் மபரிய புத்தகம் வளை 

வடிவளெக்கைாம். 
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• எளிதாக உளை,வளைகளை வடிவங்களள 
கசர்க்கைாம். 

2. கபஜ்கெக்கரில் உள்ள ஏகதனும் மூன்று கருவிளகளளயும் அதன் 
விளசப்பைளக குறுக்கு வைிகளளயும் கூறுக? 
கருவிகள் 
 

குறுக்கு வைி 
 

மைாட்கடட்டிங் டூல்(Rotataing Tool) Shift + F2 
ளைன்  டூல் (Line Tool) Shift + F3 
மைக்டாங்கில் டூல்(Rectangle Tool) Shift + F4 
எைிப்ஸ் டூல் (Ellipse Tool) Shift + F5 
பாைிகான் டூல் (Polygon Tool) Shift + F6 
3. கபஜ்கெக்கரில் உள்ள ஏகதனும் மூன்று கருவிகளின் 
குறும்படங்களளயும் அதன் பயன்களளயும் கூறுக? 

• கநர் ககாடு வளைய–ளைன் டூல் 
• கிளடெட்ட, மசங்குத்து ககாடு வளைய-கன்ஸ்மைய்ன்டு ளைன் 

டூல் 
• சதுைம்,மசவ்வகம் வளைய– மைக்டாங்கில் டூல் 
• வட்டம்,நீள்வட்டம் வளைய- எைிப்ஸ் டூல் 
• பைககாணம் வளைய- பாைிகான் டூல் 
• பக்க அளளவ மபரிதாக,சிறிதாக ொற்ற-ஜும் டூல் 
• உளை உள்ளிட- மடக்ஸ்ட் டூல் 

4. பிரிக்கப்பட்ட உளைத்மதாகுதிளய எவ்வாறு கசர்ப்பாய்? 
• மசருகும் புள்ளிளய இைண்டாவது உளைத்மதாகுதியின் கீழ்பக்க 
ளகப்பிடியில் கிளிக் மசய்து கெல்பகுதி வளை இழுக்கவும் 
• மசருகும் புள்ளிளய முதல் உளைத்மதாகுதியின் கீழ்பக்க 
ளகப்பிடியில் கிளிக்மசய்து கெல்பகுதி வளை இழுக்கவும். 

5. உளை உள்ள சட்டங்களள எவ்வாறு இளணப்பாய்? 
• இைண்டாவது சட்டம் வளைய கவண்டும் 
• முதல் சட்டத்ளத கிளிக் மசய் 
• கீழ்பக்க ளகப்பிடியில் உள்ள சிவப்பு முக்ககாணத்ளத கிளிக் 

மசய் 
• இைண்டாவது சட்டத்ளத கிளிக் மசய் 

6. ொஸ்டர் பக்கத்தின் பயன் என்ன? 
 ொஸ்டர் பக்கத்தில் ளவக்கப்படும் எந்த ஒரு மபாருளும் 
ஆவணத்தில் உள்ள எல்ைா பக்கங்களிலும் கதான்றும். ஒவ்மவாரு 
பக்கங்களிலும் மபாருளள கசர்க்க கதளவயில்ளை. 
 ொஸ்டர் பக்கம் தளைப்பு,அடிக்குறிப்பு, பக்க எண்கள், 
கைாககாக்கள் ஆகியவற்ளற மகாண்டுள்ளது. 
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 ொஸ்டர் பக்கத்தில் மபாருளள உருவாக்கைாம், திருத்தைாம், 
நீக்கைாம். 
7.ொஸ்டர் பக்கத்தில் பக்க எண்களள எவ்வாறு கசர்ப்பாய்? 

1. Master Pages பணிக்குறிளய கிளிக் மசய் 
2. T பணிக்குறிளற கிளிக் மசய் 
3. இடது ொஸ்டர் பக்கத்ளத கிளிக் மசய் 
4. Ctrl + Alt + P என்பளத கிளிக் மசய் 
5. பக்க எண் LM என கதான்றும் 
6 வைது ொஸ்டர் பக்கத்ளத கிளிக் மசய் 
7. Ctrl + Alt + P என்பளத கிளிக் மசய் 
8. பக்க எண் RM என கதான்றும் 

பகு ி ஈ 
1. கபஜ்கெக்கர் கருவிப்மபட்டியில் உள்ள கருவிகளள பற்றி 

விவரி. 
 தைொட்டடட்டிங் டூல்(Rotating Tool)  

மபாருள்களள கதர்ந்மதடுக்க ெற்றும் சுைற்ற 
ளைன் டூல் (Line Tool) 

கநர்ககாடு வளைய 
கன்ஸ்மைய்ன்டு ளைன் டூல் (Constrained LineTool) 
 கிளடெட்டொகவும் , மசங்குத்தாகவும் ககாடுகள் வளைய 
மைக்டாங்கில் டூல்(Rectangle Tool) 
 சதுைம் ெற்றும் மசவ்வகம் வளைய பயன்படுகிறது 
மைக்டாங்கில் பிகைம் டூல்(Rectangle Frame Tool) 
 சதுைம் ெற்றும் மசவ்வகம் வளைய பயன்படுகிறது. இதில் உளை 
ெற்றும் வளைகளை கசர்க்கைாம். 
எைிப்ஸ் டூல்(Ellipse Tool) 
 வட்டம் ெற்றும் நீள்வட்டம் வளைய பயன்படுகிறது. 
எைிப்ஸ் பிகைம் டூல்(Ellipse Frame  Tool) 

வட்டம் ெற்றும் நீள்வட்டம் வளைய பயன்படுகிறது.இதில் உளை 
ெற்றும் வளைகளை கசர்க்கைாம். 
பாைிகான் டூல்(Polygon Tool) 
 பைககாணம் வளைய பயன்படுகிறது. 
பாைிகான் பிகைம் டூல் (Polygon Frame Tool) 

பைககாணம் வளைய பயன்படுகிறது. உளை ெற்றும் வளைகளை 
கசர்க்கைாம். 
2. சட்டத்தில் உளைகளள ளவப்பதற்கான வைிமுளறகளளக் கூறுக? 

• கருவிப்மபட்டியில் பிகைம் டூல்களில் ஒன்ளற கிளிக் மசய் 
• சட்டம் ஒன்ளற வளையவும் 
• சட்டத்ளத கதர்வு மசய் 
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• File->Placeஎன்பளத கதர்வு மசய் 
• உளையாடல் மபட்டி கதான்றும் 
• அதில் மசருக கவண்டிய உளைளய கதர்வு மசய் 
• Openமபாத்தாளன கிளிக் மசய் 
• உளையானது சட்டத்தில் கசர்க்கப்பட்டு விடும் 

3. உளைத் மதாகுதியில் உள்ள உளைளய சட்டத்திற்கு எவ்வாறு 
ொற்றுவாய்? 

• கருவிப்மபட்டியில் பிகைம் டூல்களில் ஒன்ளற கிளிக் மசய் 
• சட்டம் ஒன்ளற வளையவும் 
• மசருக கவண்டிய உளைத்மதாகுதிளய கதர்வு மசய் 
• Shift மபாத்தாளன அழுத்திக் மகாண்டு , சட்டத்ளத கிளிக் மசய் 
• Element->Frame->Attach Content என்பளத கிளிக் மசய் 
• உளையானது சட்டத்திற்கு உள்கள கதான்றும் 

4. பாைிகான் டூளைப் பயன்படுத்தி ஒரு நட்சத்திைம் வளைவதற்கான 
வைிமுளறகளளக் கூறுக. 

• கருவிப்மபட்டியில் பாைிகான் டூளை கிளிக் மசய் 

• திளையில் சுட்டிளய அழுத்திக் மகாண்கட பாைிகான் 
வளைய கவண்டும் 

• Element->Polygon Settingsஎன கிளிக் மசய் 

• உளையாடல் மபட்டி கதான்றும் 

• Number of Sideஉளைப்மபட்டியில் 5 என தட்டச்சு மசய் 

• Star inset உளைப்மபட்டியில் 50% என தட்டச்சு மசய் 

• Ok மபாத்தாளன கிளிக் மசய் 

• நட்சத்திைம் கதான்றும் 

பொடம் 2 

 அடடொப் இன்டிமென் CC2019 

பகு ி அ 

1. ஒன்று அல்ைது அதற்கு கெற்பட்ட சட்டங்களள 
ஆக்கிைெித்திருக்கும் மதாடர்ச்சியான உளை கம (story) 

2. In Design-னுள்ள ஒவ்மவாரு உளையின் துண்டுப் பகுதியும் 
உமைச் ெட்டம்(text frame) 

3. ஆவணத்ளதச் சுற்றியுள்ள பகுதி ஒட்டுப்பைமக(pasteboard) 
4. ஒன்ளற ஒன்று பார்க்கும் வளகயில் அளெந்துள்ள இைண்டு 

ஆவணப் பக்கங்களின் மதாகுதி பைவல்(spread) 
5. …………என்பது Indesign ல் உள்ள அளனத்து கருவிகளளயும் 

மகாண்டுள்ள மபட்டியாகும். கருவிப்பைகம்(Tools panel) 
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6. பக்கத்தின் இைண்டு மநடுவரிளசகளுக்கு இளடப்பட்ட பகுதி 
Gutter 

7. ஒரு பக்கத்தில் இடம்மபரும் உளைப்பகுதி அல்ைாத உறுப்பு 
வமைகமை(Graphics) 

8. ……..என்று Adobe Photoshop கபான்ற நிைல் மூைம் உருவாக்கப்படும் 
படப்புள்ளிகளளக்(pixels) மகாண்ட நிைற்படங்கள் 
பிட்டேப்(bitmaps) 

9. இைண்டு அல்ைது மூன்று வண்ணங்கள் படிப்படியாக 
இளணத்து கைளவGradient 

10. நிறுவனங்களால் தயாரிக்கப்படும் மசயைற்ற Spot நிறங்கள்(Spot 
Colours) 

11. ஒரு மபாருளின் உள்கள இடப்படும் வண்ணம் நிைப்பு(Fill) 
12. மபாருளின் மவளிப்புறக் ககாட்டில் இடப்படும் வண்ணம் 

எல்மை(stoke) 
13. View கட்டளளகளள அதன் பயன்பாட்டுடன் மபாருத்துக 

Zoom in ஆ) அடுத்த முன்வடிவளெக்கப்பட்ட 
சதவிதத்திற்கு உருப்மபருக்கம் 
மசய்ய 

Zoom out ஈ) முந்ளதய முன் 
வடிவளெக்கப்பட்ட சதவிதத்ளத 
குளைத்தல் ெற்றும் திரும்பப்மபறல் 

Actual size அ)ஆவணத்ளத100% சதவதீம் 
காண்பிக்க 

Fit page in window உ)காட்சிதிளையின் 
அளளவ,திளையின் அளவிற்கு 
மபாருத்துவதற்காக அளவிடுதல் 

Fit spread in window இ)சன்னல் திளையில் இைக்கு 
பைவளை காண்பிக்க 
பகு ி ஆ 

1. Adobe in Design என்ன தேன்தபொருள்? 
Adobe InDesign CC 2019 என்பது ‘Adobe Creative Clud’ குடும்பத்தின் 
மென்மபாருள் நிைைின் ஒரு பகுதியாகும். 
InDesign என்பது பக்க வடிவஅளெவு மென்மபாருள் 
நிைைாகும்.இது வடிவளெப் பிற்கும் ெற்றும் வளையில் 
அச்சிடுவதற்கு அல்ைது பயன்படுத்துவதற்கான 
ஆவணங்களளள உருவாக்குவதற்கும் பயன்படுகிறது. எளிய 
வணிக அட்ளட முதல் மபரிய புத்தகம் வளை எளத 
கவண்டுொனாலும்  உருவாக்கைாம். 
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2. எத் மன வமகயொன தகொடநிமை பக்க அமேவுகள் 

உள்ளன? அமவ எமவ? 
Orientation : ஆவணத்திற்கா ன பக்க வடிவளெப்பு 2 அளவ 
Landscape or Portrait 
 

3. Adobe in Design ல் பணிப்பகு ி என்றொல் என்ன? 
InDesign- ளன மதாடங்கிய பிறகு, திளையகத்தில் காணப்படும் 
சன்னல் திளைகள் ெற்றும் தட்டுக்களின் அளெப்பு 
பணித்தளம் (workspace) எனப்படும். 
 

4. In Design ஆவண ென்னல்  ிமையில் எது அவெியேொனது? 
முதல் முளற யாக InDesignஐ மதாடங்கும் கபாது 
தானளெவாக இடம்மபறும் பணித்தளம் “Essentials” 
எனப்படும். இது கெகை கட்டுப்பாட்டுப்பைகம், இடப்புறம் 
கருவிப்பைகம் ஆகியவற்றுடன் InDesign சன்னல் திளையில் 
கதான்றும்.திளையில் கதான்றும் சன்னல்கள் ெற்றும் 
பைகங்கள் ஆகியவற்றின் அளெப்கப பணித்தளம் 
எனப்படும். InDesign பணித்தளம் பின்வரும் பகுதிகளள 
சிறப்பம்சொகக் மகாண்டுள்ள து. 
ஆவண சன்னல் (Document Window), ஒட்டு பைளக (Paste Board), 
கட்டுப்பாட்டுப் பைகம்(Control Panel), கருவிப் பைகம் (Tools 
panel) 
 

5. In Design-ல் pasteboard என்பது என்ன? 
ஒட்டுப்பைமக (Pasteboard) ஒட்டுப்பைளக என்பது ஆவணச் 
சன்னளைச் சுற்றியுள்ள சாம்பல் நிறப்பகுதி ஆகும். ஒரு 
பக்கத் தில் அவற்ளறச் மசருகுவதற்கு முன்பு 
ஒட்டுப்பைளகயில் உருப்படிகளள ளவக்கைாம். நாம் 
கவளை மசய்து மகாண்டிருக்கும் உறுப்புகளின் தற்காைிக 
கசெிப்பிற்காக 
ஒட்டுப்பைளகயின் பகுதிகளளப் பயன்படுத்தைாம். அந்த 
பக்கத்திைிருந்து உறுப்புகளளக் கிளிக் மசய்து இழுத்து விட 
கவண்டும் ெற்றும் நெக்கு கதளவப்படும் வளை அளவ 
ஒட்டுப்பைளகயில் தங்கி இருக்கும். 

6. Tool tip எப்தபொது ட ொன்றும்? 
Tools பைகத்திலுள்ள எந்த கருவி ெீதும் நாம் சுட்டியின் 
அம்புகுறியிளன ளவக்கும் மபாழுது (கிளிக் மசய்யாெல்) 

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Net                             www.TrbTnpsc.com

Send Your Questions & Answer Keys to our email id - padasalai.net@gmail.com

www.Padasalai.Net


Padasalai

tooltip கதான்றும். இது அந்த கருவியின் மபயர் ெற்றும் 
விளசப்பைளக குறுக்கு வைியிளன அளடப்பு குறிகளுக்குள் 
காட்டும் 
 

7. Page tool-ன் பயன் என்ன? 
பக்கக்கருவி (page Tool) ஒரு ஆவணத்தின் உள்கள பல்கவறு 
பக்க அளவுகளள உருவாக்க பக்கக்கருவி பயன்படுகிறது 
தவவ்டவ று பக்க அளவுகமள உருவொக்க, 
Shift + P ளய பக்க கருவளீயத் கதர்ந்மதடுக்க கிளிக் 
மசய்யவும். இப்மபாழுது கட்டுப்பாட்டுப் பக்கத்தில் (Control 
Page) உள்ள கதர்ளவப் பயன்படுத்தி பக்க அளெளவ 
ொற்றவும். 

8. Zooming என்பது என்ன? 
InDesign-ல் உள்ள சிை பணிகளுக்கு, ஒரு மபாருளள அல்ைது 
ஒரு மபாருளின் ஒருபகுதிளய உயர் உருப்மபருக்கம் 
அல்ைது  
மபரிதாக்குதல் மூைம் பார்ளவயிடுதல் கதளவப்படுகிறது. 
ஒரு ஆவணத்தில் உள்ள ஒரு மபாருளள மபரிதாக்கி (Zoom 
in) உற்று கநாக்க மபரிதாக்குதல் 
அனுெதிக்கிறது.அந்தப்மபாருளள (Zoom out) சிறியதாக்கி 
விைகிச் மசன்று பார்க்க சிறிதாக்குதல் பயன்படுகிறது. 
ஆவணத்தில் உள்ள் அளனத்ளதயும் ஒகை கநைத் தில் காண 
இது பயன்படுகிறது. ஆவணங்களளப் பார்ளவயிட 5% முதல் 
4000% வளை உருப்மபருக்கைாம் அல்ைது குளறக்கைாம்  
 

9. Tools panel –ஐ  ிறக்க/மூட உள்ள படிநிமைகமள எழுதுக 
InDesign-ல் இருக்கும் அளனத்துகருவிகளும் இந்த கருவிகள் 
பைகத்தில்இருக்கின்றன. மபாருளள உருவாக்கும் கருவிகள் 
(Rectanglel கருவி)  மபாருளள உருொற்றும் (Transforming) 
கருவிகள் (Rotate கருவி), பக்க காட்சிளய ொற்றுதல் ெற்றும் 
பணித்தளத்திற்கு மசல்லுதல் கருவிகள் (Zoom கருவி ெற்றும் 
Hand கருவி) ஆகிய கருவிகள் உள்ளன. சிை கருவிகளின் 
கீழ் வைது மூளை யில் ஒருசிறிய முக்ககாணம் இருக்கும். 
கெ லும் கூடுதைான கருவிகள் அந்த கருவியின் கீழ் 
உள்ளன. என்பளத இந்த முக்ககாணம் குறிக்கும். கிளிக் 
மசய்து அழுத்தி பிடிப்பதன் மூைம் ெளறந்திருக்கும் 
கருவிகளளக் காணைாம். 
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10. பத் ியில் எண் வரிமெ ேற்றும் புல்ைட் குறியீடு உருவொக்க 
உ வும் படிநிமைமய எழுதுக. 
ஒரு பத் ிக்கு புல்ைட்கள் அல்ைது எண்கமளச் டெர்த் ல் 
1. புல்ைட்கள் அல்ைது எண்கள் கசர்க்க விரும்பும்பத் 
திளயத் கதர்ந்மதடுக்கவும்.  
2. Type > Bulleted & Numbered Lists ளயத் கதர்ந்மதடுக்கவும், 
பிறகு Apply Bullets அல்ை து Apply Numbersளயக் கிளிக் 
மசய்யவும். 
 

பகு ி இ 
1. கருவி பைகத்ம (Tools panel) பற்றி விரிவொக விளக்கவும் 

கருவிப்பைகம், கதர்ந்மதடுப்புக்கருவிகள் (Selection tools), 
அடிப்பளட வடிவங்களள வளைவதற்கான கருவிகள், 
வளைதல்ெற்றும் புதுப்பித்தல் கருவிகள் (Drawingand editing) 
பரிொற்றல் கருவிகள் (Transformation tools) உளை பதிப்பித்தல் 
கருவிகள் (text editing tools) நகர்தல்கருவிகள் (Navigation tools) 
மபாருள் வடிவளெப் புக் கருவிகள் (Obvject formatting tools) 
கபான்ற வற்ளறக் மகாண்டுள்ளது. தானளெவாக 
கருவிப்பைகம், கட்டுப்பா ட்டுப்பைகத்திற்கு கீகை உள்ள து. 
ஆவண சன்னைின் இடது புறம் உள்ள கருவிப்பைகத்தில் 
அளனத் து கருவிகளும்காணப்படும். 

2. கருவி பைகத் ில்(Tools panel) உள்ள ஏட னும் 3 கருவிகமள 
பற்றி எழுதுக. 

ட ர்ந்த டுப்புக் கருவி(Selection tool)  இது மபாருள்களள 
அல்ைது மபாருள்களின் மதாகுதிளய 
கதர்ந்மதடுக்கப்பயன்படுகிறது. V என்ற மபாத்தாளன 
அழுத்தி இந்தக்கருவிளய கதர்ந்மத டுக்கைாம். 
டநைடி ட ர்வு கருவி (Direct Selection tool) இது ஒரு குழுவில் 
இருந்து ஒகை ஒரு மபாருளள கதர்ந்மதடுக்க (A ளவ 
அழுத்தவும்) உதவுகிறது. 

பக்கக்கருவி (page Tool) ஒரு ஆவணத்தின் உள்கள பல்கவறு 
பக்க அளவுகளள உருவாக்க பக்கக்கருவி பயன்படுகிறது. 

3. In Design-ல் உள்ள view கட்டமளகள் யொமவ? 

View பட்டியில் உள்ள Zoom கட்டளளகள்  Zoom in, Zoom out, Fitpage in 

window, Fit Spread in window,Actual SizeSpread in windo, Actual Size ெற்றும் 

Entire Pasteboard 
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4. தபரி ொக்கு லுடன்(Zooming) த ொடர்புமடய ெொர்புகளுக்கொன  
அமனத்து விமெப்பைமக குறுக்குவழிகமள பற்றி எழுதுக. 
Ctrl + = அழுத்தவும் - மபரிதாக்குதல் 

Ctrl + - அழுத்தவும் - சிறிதாக் குதல் 

Ctrl + 1 பக்கத்ளத அதன் சரியானஅளவில் காணுதல் 

 Ctrl + 2 பக்கத்ளத 200% அளவில் காணுதல் 

Ctrl + 0 ஆவண சன்னைில் முழு பக்கத்ளதயும் மபாருத்துதல் 

Alt + Ctrl + ஆவண சன்னைில் முழு பைவளையும் மபாருத்துதல் 

Ctrl + Spacebar (or)Ctrl + Alt + Spacebar தற்காைிகொக Zoom கருவிளய 

அணுகுதல்(மபரிதாக்க அல்ைது சிறிதாக்க) 
5. எழுத்துக்கமள டேதைொட்டு  அல்ைது கீடழொட்டு என 

எவ்வொறு ேொற்றுவொய்? 

எழுத்துக்கமள டேதைொட்டொக அல்ைது கீதழொட்டு ஆக 
ேொற்று ல் (Superscript Subscript) 
கட்டுப்பாட்டு தட்டில், இருந்து உளைளய கீமைாட்டு அல்ைது 
கெமைாட்டாக ொற்ற 
1. கீமைாட்டு அல்ைது கெமைாட்டாக ொற்றப்பட கவண்டிய 
எழுத்ளத கதர்ந்மதடுக்கவும். 
2. கட்டுப்பாட்டுத் தட்டில் உள்ள ஏகதனும் ஒரு 
மபாத்தாளனக் கிளிக் மசய்யவும்.கெமைாட்டு (T2 ) கீமைாட்டு 
(T2 ) 
3. கதர்வு மசய்யப்பட்ட எழுத்து கதளவப்படும் படி ொறும். 

6. ஒரு தபொருமள எப்படி உருவொக்குவொய் என விரிவொக 
விவரி. 

சிை கநைங்களில், நெது பதிப்பிற்கு கதளவப்படும் ஒகை வளக 

மபாருள் எளிய வடிவங்களாகும். வடிவங்கள் ஆவணத்ளதப் 

பார்பதற்கான ஆர்வத்ளதச் கசர்க்கின்றன. இது உளைக்கு 
பின்ன ணி யாவும் பணியாற்றுகிறது. வடிவங்களள 

உருவாக்கும் கருவிகள் Rectangle, Ellipse ெற்றும் polygon கபான்ற 
கருவிகளளக் மகாண்டுள்ள து. ஒரு வடிவகருவிளயத் 

கதர்ந்மதடுக்க, கருவிகள் பைகத்தில் Rectangle கருவி (தற்ப 

ம ாழுது கதர்ந்மதடுத்த வடிவ கருவி) ெீது கிளிக்மசய்து 

சுட்மடைி மபாத்தாளன அழுத்தி பிடித்தவாகற , நாம் 

பயன்படுத்த விரும்பும் வடிவ கருவிளயத் கதர்ந்மதடுக்கைாம். 

வடிவ கருவி கதர்ந்மதடுக்கப்பட்ட பின்,ஆவணத்தில் அளத 

இழுப்பதன் மூைம் ளகமுளறயாக (manually) வடிவத்ளத 

உருவாக்கைாம். 
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7. கருவி பைகத்திலுள்ள வளைபட சட்டங்கள் எத்தளன? 
அளவ யாளவ? 

சாதாை ண வளைகளை சட்ட கத்திைிருந்து கவறுபடுத்தைாம். 

ஏமனனில், வளைகளை சட்டகங்க ள் அச்சிடப்படாத ‘X’ 

என்பளத அதன் நடுவில் காண்பிக்கும். வளைகளை 

சட்டகங்கள் பிற மென்மபாருள் நிைல்க ளில் உள்ள 

படங்களளத் தருவித்துக்மகாள்ள பயன்படுகிறது. InDesign ல் 

தருவிக்கப்பட்ட அளனத்து படங்களும் வளைகளை 

சட்டகங்களின் உள்கள இருக்கும். வளைகளை சட்டகங்களள 

வளைவதற்கு கருவிகள் பைகம் மூன்று கருவிகளளக் 

மகாண்டுள்ள து. 

Ellipse சட்டகம் இந்த கருவிளயப் பயன்படுத்தி நீள்வட்ட (oval) 

ெற்றும் வட்ட (round)-சட்ட கங்களள உருவாக்கைாம். 

Rectangle சட்டகம் இந்த கருவிளயப் பயன்படுத்தி மசவ்வக 

ெற்றும் சதுை சட்டகங்களள உருவாக்கைாம். 

Polygon சட்டகம் இந்த கருவிளயப் பயன்படுத்தி செபக்க பைககா 

ண (equilateral polygon)சட்டகங்களள உருவாக்கைாம். 
பகு ி ஈ 

1. InDesign-ல் பு ிய ஆவணத்ம  உருவொக்குவ ற்கொன 
படிநிமைகமள எழுதுக. 

1. Start-> All programs ->Adobe Indesign CC 2019 என்பளத கத ர்வு 

மசய்யவும் (அல்ை து) திளைமுகப்பில் உள்ள InDesign குறுக்கு 

வைிளயத் கதர்வு மசய்யவும் 
2. “Welcom to InDesign” என்ற சன்னல் திளை திறக்கப்படும். 3. 
3. இப்மபாழுது Create New மபாத்தாளனக் கிளிக்மசய்யவும் 
இப்மபாழுது New Document window புதிய ஆவண சன்ன ல் 

திறக்கப்படும். புதிய ஆவணத்ளத உருவாக்கும் மபாழுது New 

Document உளையாடல் மப ட்டியில்பை கதர்வுகளள 

மபாருத்துவதற்கான வாய்ப்பு கிளடக்கும். புதிய ஆவணத்தில் 

அடிப்பளடகதர்வுகளள மபாருத்துவதற்கு. 

● New Document உளையாடல் மப ட்டியில் Category தத்தைில் உள்ள 

print, web அல்ைது Mobile ஐ கதர்வு மசய்யவும். 

பின்வ ரும் கதர்வுகளள ஏற்கனகவ கதர்வுமசய்யப்பட்ட மதாகுதியில் 

குறிப்பிடவும். 

Width and Hight : ஆவணத்தின் அளளவ குறிப்பிடுகிறது. 

Units: ஆவணத்ளத அளவிடுவதற்கான அைளகக் குறிப்பிடுகிறது. 
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Orientation : ஆவணத்திற்கான பக்க வடிவளெப்ளப (Landscape or Portrait) 

குறிப்பிடுகிறது. 

Pages : ஆவணத்தில் உருவாக்கப்படும் பக்கங்களின் எண்ணிக்ளகளய 

குறிப்பிடுகிறது. 

Facing Pages: ஒரு பக்கத்ளத ெட்டுகெ உளடய ஆவணத்ளத உருவாக் 

குவதற்கு 

எடுத்துக்காட்டாக விளம்பைங்கள், சுவமைாட்டிகள், அல்ைது துண்டு 

பிைசுைங்கள் –ஆகியவற்றுக்கு Facing Pagesஐ Turn off மசய்ய கவண்டும். 

புத்தகங்கள் ெற்றும் இதழ்கள் ஆகியவற்றுக்கு Facing Pages ஐ Turn on 

மசய்ய கவண்டும். ஏமனனில், இளவ வைது, இடது அல்ை து முன், பின் 

என இரு பக்கங்களளயும் மகாண்டிருக்கும். 

Start #: எந்த எண்ணில் ஆவணம் மதாடங்குகிறது என்பளதக் 

குறிப்பிடுகிறது. 

கதர்ந்மதடுக்கப்பட்ட Facing Pages உடன் இைட்ளடப் பளட எண்களள (அதா 

வது 2) என்பளதக் குறிப்பிட்டால் ஆவணத்தின் முதல் பைவல் இைண்டு 

பக்க பைவலுடன் மதாடங்குகிறது. 

Primary Text Frame: முதன்ளெ பக்கத்தில் (Master Page) முக்கிய உளைளயச் 

கசர்க்க(Primary text) இந்தத் கதர்ளவ கதர்ந்மதடுக்கவும். 

Columns: ஆவணத்தில் கசர்க்கப்பட கவண்டிய மநடுவரிளசகளின் (Column) 

எண்ணிக்ளகளயக் குறிப்பிட பயன்படுகிறதுColumn Gutter: மநடுவரிளச 

களுக்கு இளடகய உள்ள இளடமவளியின் அளளவக் குறிப்பிட 

உதவுகிறது. 

Margins: ஆவணத்தின் ஒவ்மவாரு பக்கத்திற்கும் ஒரு அளளவ குறிப்பிட 

பயன்படுகிறது. 

பல்கவறு பக்கங்களுக்கு பல்கவறு ெதிப்புகளளப் பயன்படுத்துகிறது. 

Chain பணிக்குறிளய 

கிளிக் மசய்வதன் மூைம் அளவுகளள பிரிக்க முடியும். 

Bleed and Slug: ஆவணத்தின் ஒவ்மவாரு பக்கத்தினுடகன Bleed and Sug 

இருப்பிடத்ளத குறிப்பிடுகிறது. Chain பணிக்குறிளய கிளிக் மசய்வதன் 

மூைம் அளவுகளள பிரிக்க முடியும். 

4. முன்கப இருத்தப்பட்ட அளெப்புககளாடு ஆவணத்ளதத் திறக்க Create 

மபாத்தான்களளக் கிளிக் மசய்யவும். 

2. ெிறு குறிப்பு எழுதுக. 
பயன்பொட்டு பட்மட (Application bar) 

இது பணித்தளத்திற்கு கெல் உள்ளது. இதில் பை பட்டிகள் (menu) 

உள்ளன. ஒரு பட்டிளயத் திறக்க, பயன்பாட்டு பட்ளடயில் உள்ள 

பட்டியின் மப யளைக் கிளிக் மசய்யவும். ஒவ்மவாரு பட்டியும் 

பட்டிவளககயாடு மதாடர்புளடய கட்டளளகளளப் பட்டியைிடும் 

பட்டிப்மபயர்களின் 
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வைதுப்புறத்தில் பணித்தளமும் ெற்றும் View கதர்வுகளும் உள்ளன. 

ஆவணத்  த்  ல் (Document tab) 

ஆவணத் தத்தல், கிளட ெட்ட ரூைர்க்கு கெல்பகுதியில் உள்ளது. இது 

ஆவணத்தின் மபயர், உருப்மபருக்த்தின் நிளை (Magnification) ெற்றும் 

மூடு மபாத்தான் ஆகியவற்ளறக் மகாண்டுள்ளது. ஒன்றிற்கு 
கெற்பட்ட ஆவணங்க ள் திறந்திருந்தால்,ஒவ்மவாரு ஆவணத்திற்கும் 

ஒரு தத்தல் 

கதான்றும் ெற்றும் ஆவணத்தத்தல்கள் கிளடெட்ட வரிளசயில் 

கதான்றும்.ஆவணத் தத்தளை கிளிக் மசய்து, அந்தஆவணத்ளதச் 

சன்னல்திளையில்காணைாம். முழுளெயான சன்னல்திளையில் 

ஆவணத்ளதத் திறக்க, ஆவணத் தத்தளை கிளிக் மசய்து இழுத்து 

குழுளவ விட்டு மவளிகயற்ற கவண்டும். 

கருவிகள் பைகம் (Tools Panel) 

InDesign-ல் இருக்கும் அளனத்து கருவிகளும் இந்த கருவிகள் 

பைகத்தில் 

இருக்கின்றன. மபாருளள உருவாக்கும்கருவிகள் (Rectanglel கருவி) 
மபாருளள உருொற்றும் (Transforming) கருவிகள் (Rotate கருவி), பக்க 

காட்சிளய ொற்றுதல் ெற்றும் பணித்தளத் திற்கு மசல்லுதல் 

கருவிகள் (Zoom கருவி ெற்றும் Hand கருவி) ஆகிய கருவிகள் உள்ளன. 

சிைகருவிகளின் கீழ்வைது மூளையில் ஒரு சிறிய முக்ககாணம் 

இருக்கும். கெ லும் கூடுதைான கருவிகள் அந்த கருவியின் கீழ் 

உள்ளன. என்பளத இந்த முக்ககாணம் குறிக்கும். கிளிக் மசய்து 

அழுத்தி பிடிப்பதன் மூைம் ெளறந்திருக்கும் கருவிகளளக் 
காணைாம். 

4. பொம யில் ஒரு வமகயிமன உருவொக்க படிநிமைகமள எழுதுக. 

ஒரு பாளதக் கருவியில் தட்ட ச்சு மசய்வதன் மூைம், ஒரு 

பாளதயின் உள் அல்ைது மவளிப்புற விளிம்பில் தட்டச்சு 

கசர்க்கைாம். பாளதயின் ஏகதனும் ஒரு பக்கத்தில் உளைளயச் 
கசர்க்கைாம். ஆனால் இைண்டு பக்கங்க ளிலும் கசர்க்க முடியாது. 

முதைில் உளைளய உள் பக்க பாளதயில் கசர்த்திருந்தால் அளத 

பிறகு மவளிப்பக்கொக நகர்த்திக் மகாள்ளைாம். ஒரு பாளத யில் 

உளைளயத் கதர்ந்மதடுக்கும் கபா து, அளடப் புக்குறிக்குள் 

கதான்றும். அதன் நிளைளயச் சரிமசய்து உளைளய ச் 

சரிமசய்யைாம். 

பொம  யில்  ட்ட ச்சு உருவொக்கு ல் 

1. கருவிப் பைகத்தில் பாளத க்கருவியில் உள்ள தட்டச   ளச கத ர்வு 

மசய்யவும். 
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2. தட்டச்ளச கசர்க்க பாளதயின் விளிம்பில் கிளிக் மசய்யவும். 

(திறந்து அல்ைது மூடி)உளைச் சட்டகத்தில் ஒரு ஒளிரும் மசருகும் 

புள்ளி த�க ா ன்றும். மபாருளில் உள்ளஎல்ளை நீக்கப்படும். 

ஏகதனும் உளைளயத் தட்டச்சு மசய்யவும். உளை தானாககவ ெடிந்து 

உளைச்சட்டகத்திற்கு ஏற்றவாறு அளெயும். ‘Enter’ மபாத்தாளன 

அழுத்த கவண்டியதில்ளை. 

3. மபாருளின் விளிம்பில் தட்டச்சு கதா ன்றும். எல்ளைகளள 

நீக்கிவிட்டு அதன் வடிவத்தில் உறுதியாக அளெகிறது. Overflow 

குறியீடு கதான்றினால் உளைச்சட்ட கத்தின் கதர்ளவ நீக்கி, 
கதர்வுக்கருவிளய கருவிப்பைகத்தில் இருந்து கத ர்வு மசய்து 

உளைச்சட்ட கத்தில் ஒருமூளையில் இழுக்கவும்.கதர்வுக்கருவிளய 

கத ர்வு மசய்யவும் அல்ை து தட்ட ச்சு கருவிளய ெீண்டும் 

கதர்வுமசய்யவும். 
5. ஆவணத் ில் உமையிமன மவக்க படிநிமைகமள எழுதுக. 

0InDesign ஆவணத்தில் கவறு ஒருஆவணத்தின் உளைளய கசர்க்க 

விரும்பினால் ‘Place’ கட்டளளளயப் பயன்படுத்த கவண்டும். 

பின்வரும் 

உளைவடிவங்களிைிருந்து உளைளயத்தருவிக்கைாம். Plain T Text (TXT) 

RichText Format (RTF), Microsoft word(Doc or Docx) or Microsoft Excel (Xls 

or XLSX). File பட்டியில் உள்ள placeகட்டளளளயப் பயன்படுத்தி 
உளைளயத்தருவிக்கும் மபாழுது InDesign புதியஉளைச்சட்டகம் 

அல்ைது ஏற்கனகவ உள்ளஉளைச்சட்டகத்தில் உளைளய 

இருத்தஅனுெதிக்கிறது 
பின்வரும் படிநிமைகமள பின்பற்றுக. 

1. பட்டிப்பட்ளடயில் இருந்து File →Place ஐ கத ர்வு மசய்க. 

2. Place உளையாடல் மப ட்டி கதா ன்றும். 

3. இருத்தப்பட கவண்டிய உளைக்ககா ப்ளப கதர்வு மசய்து place 

உளையாடல் மப ட்டியின் வைது 

பக்கத் தில் உள்ள Open மபாத்தாளன கிளிக் மசய்யவும். 

4. மசருகும் புள்ளி மசறிவூட்டப்பட்டஉளை மசருகும் புள்ளியாக 

ொறுகிறது. இது ஆவணத்தில் உளை மசருகுவதற்கு தயாைா க உள்ளது 
என்பளத மதரிவிக்கிறது. 

5. உளைளய இருத்துவதற்கு கிளிக்மசய்யவும் (அகத பக்கத்தில் 

மசருகுவதற்கு) அல்ைது புதிய உளைச்சட்டகத்ளத 

உருவாக்குவதற்கு கிளிக் மசய்துஇழுக்கவும். 

6. உளைளய உளைச்சட்டகத்தில்இருத்த முடியவில்ளை எனில், 

ஒரு சிவப்பு+குறியானது,உளைசட்ட கத்தின் கீழ் வைது 

எல்ளையில் Overflow குறியீடாககதா ன்றும். 
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7. இந்த Overflow குறியீட்ளட கிளிக் மசய்தால் ெீதமுள்ள உளைமசருகும் 

புள்ளியில், கூடுதல்உளைச்சட்ட கத்தில் உளைளய ச் கசர்ப்பதற்கா க 

ஏற்ற ப்படுகிறது. உளையானது கிளிக்மசய்யும் மபாழுது இருத்தப்படும். 

கிளிக் மசய்து இழுத்தா ல் புதிய உளைச்சட்ட கம்கூடுதல் உளையுடன் 

உருவாக்கப்படும். புதிய உளைச்சட்ட கம் முன்ன ர் உள்ள உளைச்சட்ட 

கத்துடன் இளணக்கப்படும். இவ்வாறு இளணக்கப்படும் கபாது 
உளைசட்ட கத்தின் அளவு அல்ைது உளையின் வடிவூட்டல் உளையானது 

இைண்டு சட்டகங்க ளுக்கு ொற்றப்பட்டால் இளடகய எளிதாக 

நகர்கிறது. 
6. வமைகமை ெட்டத் ில் எவ்வொறு படத்ம  டெர்ப்பொய் என 

படிநிமைகமள எழுதுக. 
வமைகமை ெட்ட த் ில் படத்ம  ச் தெருகு ல் 

வளைகளை சட்ட கம் பிற மென்மபாருள் நிைைில் உள்ள படங்களளத் 

தருவிக்க பயன்படுகிறது. 

சட்டகத்தில் படங்களளச் மசருகைாம். 

1. வளைகளை சட்ட கத்ளத உருவாக் கு 

2. File > Place என்பளதத் கதர்ந்மதடுக்கவும். Place உளையாடல் மபட்டி 

கதான்றும். 

3. சட்டகத்தில் மசருக விரும்பும் படத்ளதக் கண்டுபிடித்து 

கதர்ந்மதடுக்கவும். 

4. Open ெீது கிளிக் மசய்யவும். 

 

பொடம் 3 

டகொைல்ட்ைொ 2018 (CorelDRAW 2018) 

பகு ி – அ 

1. _________ என்பது ஒரு மவக்டர் வளைகளை பயன்பாடாகும். 

டகொைல்ட்ைொ 

2. மவக்டார் வளைகளையானது _________ மகாண்டு உருவாக்கப்ப 

டுகின்றது, டகொடுகள் ேற்றும் வமளவுகள் 

3. _________ என்பளவ மசவ்வகப்படம் (raster image) என அளைக்கப்ப 

டுகின்றன. பிட்டேப்ஸ் 

4. _________ ளன பயன்படுத்தி நாம்  மவக்டார் வளைகளையிளன 

   உருவாக்க முடியும். டகொைல்ட்ைொ 
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5. மசந்தை கருவிப்பட்ளடக்கு (Stadard toolbar) அடுத்திருப்பது _________. 

பண்பு பட்மட 

6. எந்த கருவி ஒரு மபாருளிளன கதர்வு மசய்ய உதவுகின்றது? Pick 

கருவி 
7. வட்டத்ளத வளைய அந்த கருவி உதவுகின்றது Ellipse கருவி 
8. எத்தளன வளக சுருள்கள் உள்ளன? 2 

9. _________ சாவியானது Freehand கருவியிளன கதர்வு மசய்ய 

உதவுகின்றது.F5 
10. Corel Drawவில் ஒரு ஆவணத்ளத மூட _________ ளன அழுத்த 
கவண்டும். Ctrl + F4 

11. Corel Draw விட்டு மவளிகயற Alt+F4 

12. _________ சாவி ஒரு மபாருளள கதர்வு மசய்தளத நீக்க 

உதவுகின்றது ESC 

13. _________ சாவி கசர்ொனம் கதர்வு மசய்யப்பட்ட மபாருளின் 

பிைதியிளனஉருவாக்க உதவுகின்றது. Ctrl +D 

14. இளணக்கப்பட்ட மபாருளிளன தனித்தனிகய பிரிக்க 

_________ளன அழுத்தவும்.,Ctrl+K 

15. இைண்டு அல்ைது அதற்கு கெற்பட்ட மபாருட்களள இளணக்க 

_______ளன அழுத்தவும்.Ctrl+L 

 

பகு ி – ஆ 

II. மூன்று வரிகளில் விளட யளிக்கவும் 

1. Corel Draw எ ற்கொக பயன்படுத் ப்படுகின்றது? 

CorelDraw என்பது உயர்தை வளைகளை சித்திைங்கள், கைாககா 
வடிவளெப்பு ெற்றும் பக்க அளெப்புகளள உருவாக்குவதற்கான 

பல்துளற வளைகளை பயன்பாடு ஆகும். 

2. Corel Drawவில் ஒரு பு ிய ஆவணத்ம  உருவொக்க படிநிமைகமள      

 எழுதுக. 

ஒரு பு ிய ஆவணத்ம  உருவொக்க 

1. வைகவற்பு திளையில் New Document மபாத்தாளன கிளிக் 

மசய்யவும். 

2. இப்கபாது Create a New Document உளையாடல் மபட்டி கதான்றும். 

இது ஆவணத்தின் பை பண்புகளள உள்ளிட அனுெதிக்கிறது. 

3. நீங்கள் அதில் ஆவணத்திற்கு மபயரிடவும், பக்க அளவு 

அளெக்கவும், CMYK அல்ைது RGB கபான்ற நிற முளறளெளயத் 

கதர்வு மசய்யவும், வண்ண விபைங்களளயும் அளெக்கைாம். 

4. OK மபாத்தாளன கிளிக் மசய்யவும் 

3. Corel Drawவில் டொக்கர் (Docker) என்றொல் என்ன? 
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டாக்கர் (docker) என்பது குறிப்பிட்ட கருவி அல்ைது பணிக்கான 

கட்டளளகள் ெற்றும்அளெப்புகளள மகாண்ட ஒரு சன்னல் 

திளையாகும் 
4. Corel Draw விமன த ொடங்குவ ற்கொன  படிநிமைகமள எழுதுக. 

நாம் CorelDRAW 2018 கநை டியாக நெது கணினியின்  ிமைமுகப்பில் 

(Desktop) இருந்கதா அல்ைது Windows த ொடக்க பட்டியில் (Start Menu) 

இருந்கதா மதாடங்கைாம். 

1. Start > All Programs >CorelDRAW Graphics Suite 2018 >CorelDRAW2018 என்பளத 

கதர்ந்மதடுக்கவும் (அல்ைது) 
2. திளைமுகப்பில், CorelDRAW 2018 குறுக்குவைி குறும்படத்ளத 

கண்டறியவும். இது ஒரு வண்ணெயொன பலூன் 

வடிவகுறும்படம். அதன் கீழ் CorelDRAW2018 என்று 

குறிப்பிடப்பட்டிருக்கும்.அதளன இைட்ளடக் கிளிக்மசய்து 
திறக்கைாம். 

 

5. Corel Draw வில் ஒரு தபொருள் என்றொல் என்ன? 

 

கருவிகளள (tools) மகாண்டு நாம் உருவாக்கும் வளைபடங்கள் 

மபாருட்கள் எனப்படும். 

6. Corel Draw வில் பண்பு பட்மட(Property Bar) என்றொல் என்ன? 

பண்புப்பட்ளட (Property bar) மசந்தை கருவிப்பட்டிக்கு அடுத்து 

இருக்கும். இயக்க கருவிக்கு மதாடர்புளடய மபாதுவான 

மசயல்பாடுகளள இது காட்டுகிறது. இது கருவிப்பட்டிளயப் 

கபாை கதான்றினாலும், கருவி அல்ைது பணிளயப் மபாருத்து 

பண்புகள் பட்ளடயின் உள்ளடக்கம் ொறுகிறது. 

7. Corel Draw வில் ரூைர் (Ruler) ஏன் பயன்படுத் ப்படுகின்றது. 

சாளைத்தில் இைண்டு ரூைர் இருக்கும். அளவ கிளடெட்ட ரூைர் 

ெற்றும் மசங்குத்து ரூைர் . அளவ ஒரு ஆவணத்தில் 

மபாருட்களின் அளவு ெற்றும் நிளைளய தரீ்ொனிக்கப் 

பயன்படுத்தப்படுகின்றன 
8. Corel Draw வில் கமைத் ிறனுள்ள ஊடக கருவி (Artistic Media tool) 

 ஏன் பயன்படுத் ப்படுகின்றது? 

களை தூரிளக , மதளிப்பு ெற்றும் calligraphic விளளவுகளள 

கசர்ப்பதற்கு பயன்படுகிறது. 
9. தபொருட்கமள குழுவொக்க படிநிமைகமள எழுதுக. 

1. Pick கருவி மகாண்டு மபாருள்களள கதர்வு மசய்யவும். (பை 

மபாருள்களள கதர்வு மசய்ய Shift சாவியிளன அழுத்தியவாறு 

கதர்வு மசய்யவும். 
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2. Object > Group > Group objects என்பளத கதர்வு மசய்யவும் (அல்ைது) 

Ctrl + G ளன அழுத்தவும். கதர்வு மசய்யப்பட்ட மபாருட்கள் ஒகை 

மபாருளாக  குழுவாக்கப்படும். 

10. குழுவொக்கப்பட்ட தபொருளின் குழுவொக்கத்ம  நீக்க படிநிமைகமள 

  எழுதுக. 

1. Pick கருவி மகாண்டு குழுவாக்கப்பட்ட மபாருளள கதர்வு 

மசய்யவும். 

2. பட்டிபட்ளடயிைிருந்து Object >Group > Ungroup Objects என்பளத கதர்வு 

மசய்யவும் (அல்ைது) விளசப்பைளகயிலுள்ள Ctrl + U என்பளத 

அழுத்தவும் அல்ைது Property பட்ளடயிலுள்ள Ungroup objects என்பளத 

கிளிக்மசய்யவும். குழுவாக்கப்பட்ட மபாருளானது அதனுளடய 

மபாருட்களின் கூறுகளாக பிரியும் 

பகு ி – இ 

III. ஒரு பத்தியளவில் விளட யளிக்கவும் 

1. தவக்டொர் வமைகமைக்கும் பிட்டேப்ஸ் (Bitmaps) க்கும் இமடடய 

உள்ள டவறுபொடுகள் யொமவ ? 

மவக்டர் வளைகளையானது (Vector graphics) ககாடுகள் ெற்றும் 

வளளவுகள் மகாண்டு உருவாக்கப்படுகின்றது. இளவகள் 

கணிதத்திற்குரிய விளக்கங்களள மகாண்டு 
உருவாக்கப்படுகின்றன. இவ்வளகயான வளைகளையானது 

சின்னங்கள் ெற்றும் விளக்கப்படங்கள் (Logos and illustrations) 

ஆகியவற்றிற்கு ஏற்றளவ ஆகும். 

பிட்கெப்ஸ் (Bitmaps) என்பது மசவ்வகப்படம் (Raster images) என 

அளைக்கப்படுகின்றது. இது படபுள்ளிகள் (Pixels) என 

அளைக்கப்படும் சிறிய சதுைங்களள மகாண்டு 

உருவாக்கப்படுகின்றது. 

2. Corel Draw வில் ஒரு தெவ்வகத்ம  வமைவ ற்கு படிநிமைகமள 

எழுதுக. 

1. ஒரு மசவ்வகத்ளத வளைய கருவிப்பட்ளடயில் இருந்து Rectangle 

கருவிளய கதர்ந்மதடுக்கவும். சுட்டி சிறு சதுைத்ளத மகாண்ட 

crosshair சுட்டியாக ொறும். 

2. வளைதல் பகுதியில் எங்கு கவண்டுகொ அங்கு கிளிக் மசய்து 

மகாண்கட இழுக்கவும். நாம் சுட்டிளய இழுக்க , ஒரு மசவ்வக 

கதான்றும். 

3. கதளவயான அளவுள்ள மசவ்வகம் கதான்றியவுடன் சுட்டி 

மபாத்தான் அழுத்துவளத விட்டுவிட கவண் டும். 

4. இப்கபா து ஒரு மசவ்வகம் திளையில் கதான்றும். 

3. Corel Draw வில் வட்டத்ம  வமைய படிநிமைகமள எழுதுக. 
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1. வட்டம் வளைய நீள்வட்ட Ellipse கருவிளய 

கருவிபட்ளடயிைிருந்து கதர்ந்மதடுக்கவும். சுட்டியின் வடிவம் 
Crosshair குறியுடன் கீழ்ப்ப குதியில் நீள்வட்டம் மகாண்டு குறியாக 
இருக்கும். 

2. இப்கபாது வளையும் பகுதியில் எங்கு வட்டம் வைகவண்டுகொ 

அங்கு ctrl விளசளய அழுத்தி ளவத்தவாறு சுட்டியின் இடது 

மபாத்தாளன இழுத்து நகர்த்த கவண்டும். 

3. நீங்கள் விரும்பும் வட்டவடிவம் கதான்றியவுடன் சுட்டியின் 

மபாத்தாளன அழுத்துவளத விட்டுவிடவும். 

4. இைண்டு வமகயொன சுருள்கள் என்பமவ என்ன? விளக்குக. 

    இைண்டு வளகயான சுருள் வளககள் உள்ளன 

1. செசரீ் சுருள் (Symmetrical spiral) 

2. ெடக்ளக சுருள் (Logarithmic spiral) 

செசரீ் சுருள் முளறயில் சுருள் செஅளவில் விரிவளடயும். 

எனகவ 

ஒவ்மவாரு சுைற்சியும் செ அளவுளடய சுருளள உருவாக்கும். 

ெடக்ளக சுருள் முளறயில் சுைற்சி உருவாக்கும் 
சுருள்களுக்கிளடகயயான தூைம் அதிகரித்தவாகற காணப்படும். 

நாம் spiral கருவிளய மகாண்டு பை அளவுகளில் சுருள்களள 

வளைய முடியும். 

5. Flyoutனுமடய எந்  கருவியொனது நட்ெத் ிை கருவியிமன 

தகொண் டிருக்கும்? 

Flyoutன் Polygon tool  நட்சத்திை கருவிளயக் மகாண்டிருக்கும். 
குறுக்குவைி சாவி  Y  ஆகும் 
Polygon tool (Y) - Polygon, Star, Complex Star, Impact tool, GraphPaper, Spiral, Basic 

Shapes, ArrowShapes, Flowchart Shapes, BannerShapes ெற்றும் Callout Shapes 

கருவிகளள அணுக உதவுகிறது.  
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6. Corel Draw வில் பிமழகமள ெரி தெய்ய என்ன தெய்ய டவண்டும்? 

அ மன தெய்வ ற்கொன விமெப்பைமக குறுக்கு வழி என்ன? 

நடப்பு அெர்வில் நாம் முன்னர் மசய்தமசயல்பா டுகளள Corel Draw 

நிளன வில் மகாண் டிருக்கும். ெிக செீபத்தில் நாம் மசய்த 

மசயைில் ஆைம்பித்து, நாம் வளையும்மபாழுது மசய்த 

மசயல்களள எல்ைா ம் உங்களால் Undo மசய்ய முடியும். ஒரு 

மசயளை Undo (மசய்தளத நீக்கு) மசய்வதினால் வரும் 

விளளவுகள் உங்களுக்கு பிடிக்க வில்ளை எனில் நாம்  அதளன 

Redo (ெறுபடியும் மசய் ) மசய்து மகாள்ளைாம். 

To Undo, Redo and Repeat தெயல்கள் 

ஒரு மசயளை Undo மசய்ய Edit > Undo கதர்வு மசய்யவும் (களடசி 
மசயல்) 

ஒரு மசயளை Redo மசய்ய Edit > Redo கதர்வு மசய்யவும்  
வளைபடத்தின் களடசியாக கசெிக்கப்ப ட்டநிளைக்கு 
பின்தெல்ை File > Revert கதர்வு மசய்யவும் 

ஒரு மசயளை ெீண்டும் ெீண்டும் மசய்ய Edit > Repeat கதர்வு 

மசய்யவும் 

7. ஒரு டகொட்டிமன அம்புகுறியொக ேொற்றுவ ற்கு நீங்கள் என்ன 

தெய்வரீ்கள்? 

1. Freehand கருவி மூைம் ஒரு ககா டு வளையவும். 

2. ககாட்ளட கதர்ந்மதடுக்கவும். 

3. பண்புபட்ளடயில் உள்ள End Arrow head Selector கீகை இறங்கு 

பட்டிமபட்டியில் கிளிக் மசய்யவும். 
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4. பின் கதளவயான அம்புக்குறி முளனளய கதர்வு மசய்யவும். 

இப்கபாது ககாடு அம்புக்குறியுடன் கதான்றும்.  

8. ஒரு தபொருளுக்கு நிைப்பு வண்ணத்ம யும் ேற்றும் 
எல்மைடகொட்டின் வண்ணத்ம யும் எவ்வொறு குறிப்பிடுவொய்? 

1. Pick கருவிளய பயன்படுத்தி மபாருளளத் கதர்ந்மதடுக்கவும். 

2. வண்ணத்தட்டில் ஏதாவது ஒரு வண்ணத்ளத கிளிக்மசய்யவும். 

3. கதர்ந்மதடுக்கப்பட்ட மபாருளுக்கு வண்ணங்கள் 

கசர்ந்திருக்கும். 

4. வண்ணத்தட்டில் உள்ள ஏதாவது ஒரு வண்ணத்தில் ளவத்து 

வைது மபாத்தாளனக் கிளிக் மசய்யவும். 

5. கதர்ந்மதடுக்கப்பட்ட மபாருளின் வண்ணம் 

கதர்ந்மதடுக்கப்பட்ட 

வண்ணத்திற்கு ொறியிருக்கும். 

9. மபாருட்களின் பிைதி ெற்றும் மபாருட்களின் நகைியிளன எவ்வாறு 

உருவாக்குவாய்? இைண்டிற்கும் உள்ள கவறுபாட்ளட எழுதவும். 

ட ர்வு தெ ய்யப்ப ட்ட தபொருமள நகல் எடுத் ல். 

பட்டி பட்ளடயிைிருந்து Edit >Dupilicate என்பளத கதர்வு மசய்யவும் 

அல்ைது விளசப்பைளகயில் Ctrl + D என்பளத அழுத்தவும். 

நகைானது அசல் மபாருளின் கெற்புற வைது புறத்திைிருந்து 

சற்று நகர்ந்து கீழ்கண்டவாறு கதான்றும். புதிய நகைானது 

தானாககவ கதர்வு மசய்யப்பட்டு வரும். 

தபொ ருட்கமள நகைி தெ ய் ல் (Cloning Obejects) 

கதர்வு மசய்யப்ப ட்ட மபாருளின் நகைி (Clone) ளய உருவாக்க Edit > 

Clone என்பளத பட்டிபட்ளடயிைிருந்து கதர்வு மசய்யவும். 

நகைியானது அசல் மபாருளின் கெ ற்புற வைது புறத்திைிருந்து 

சற்று 

நகர்ந்து கீழ்கண்டவாறு கதான்றும். புதிய நகைானது தானாககவ 

கதர்வு மசய்யப்பட் டு விடும். நகைி மசய்தல் பிைதி எடுத்தைிருந்து 

கவறுபட்டதாகும். அசல் மபாருளின் ெீது மசய்யப்படும் அளனத்து 

ொற்றங்களும் நகைி ெீதும் தானாககவ மசயற்படுத்தப்படும். 

எடுத்துக்காட்டாக நாம் அசல் மபாருளின் நிைப்பிளய (Fill) ொற்றும் 

மபாழுது, நகைியினுளடய நிைப்பியும் ொறும்.  

10. தபொருள்கமள தவல்டிங் தெய்வ ன் மூைம் என்ன தபற 

முடியும்? தபொருள்கமள தவல்டிங் தெய்வ ற்கொன படிநிமைகமள 

எழுதுக. 

மவல்டிங் மசய்வதன் மூைம் ஒழுங்கற்ற வடிவங்களள நாம் 

உருவாக்க முடியும்.நீங்கள் உருவாக்க முடியும். மவல்டிங் 

மசய்யப்பட்ட மபா ருட்கள் 
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களடசியாக கதர்வு மசய்யப்பட்ட மபாருளின் எல்ளை 
ககாட்டிளனயும், நிைப்புதளையும் எடுத்து மகாள்ளும். மவல்டிங் 

மசய்யப்பட்ட மபாருட்களள ெீண்டும் தனித்தனி மபாருட்களாக 

ொற்றியளெக்க Undo மபாத்தாளன ெட்டுகெ பயன்படுத்த முடியும். 

Property பட்மட தகொண்டு தபொருள்கமள தவல்டிங் தெய்ய 

1. Pick கருவி மகாண்டு (அல்ைது) Shift சாவியிளன அழுத்தியவாறு 

மபா ருள்களள கதர்வு மசய்யவும். 

2. Object > Shaping > Weld என்ற கட்டளளயிளன பட்டி 
பட்ளடயிைிருந்து கதர்வு மசய்யவும்(அல்ை து) Property 

பட்ளடயிலுள்ள Weld மபாத்தாளன கிளிக்மசய்யவும். 

3. மபாருள்கள் மவல்டிங் மசய்யப்பட்டு,ஒகை எல்ளைககாடு 

மகாண்ட 

மபாருளாக ொறும். 

 
 

பகு ி – ஈ 

IV. ஒரு பக்க அளவில்விமட யளிக்கவும் 

1. சுருளிமன (Spiral) வமைய படிநிமைகமள எழுதுக. 

சுருள் வமைய 

1. பைககாண கருவியின் ெீது அழுத்திப் பிடித்தவாகை இருந்தால் 

flyout பட்டி கதான்றி கெலும் பை கருவிகளள காட்டும். 

2. flyout பட்டியில் உள்ள சுருள் (Sprial) கருவிளய கிளிக் மசய்யவும். 

3. நாம் பண்பு பட்ளடயில் உள்ள சுருள் சுைற்சி மபட்டியில் 

எண்ணிக்ளகளய மகாடுப்பதன் மூைம் கதளவயான வட்டம் 

உளடய புதிய சுருள் அளெப்ளப உருவாக்க முடியும். 

4. பின் பண்புபட்ளடயில் கீழ்கண்ட ஏகதனும் ஒரு மபாத்தாளன 

கிளிக் மசய்யவும். 

● செசரீ் சுருள் (Symmetrical spiral) 

● ெடக்ளக சுருள் (Logarithmic spiral) 

சுைற்சிளய மவளிப்புறொக நகர்த்தும் கபாது சுருள் விரிவாக்க 

அளவுகளள ொற்ற விரும்பினால் spiral expansion slider ஐ 

நகர்த்தவும். 

வளையும் சன்னல் திளையில் நெக்கு கவண்டிய அளவு உள்ள 

சுருள் வரும் வளை சுட்டிளய கிளட ெட்டொக இழுக்கவும் 

2. பைடகொணங்கமள (Polygon) மய படிநிமைகமள எழுதுக. 

1. பைககாண உருவம் வளைய (ஐங்ககாணம் - ஐந்து பக்கம் உளடய 

உருவம் என்றும் அறியப்படுகிறது) polygon கருவிளய 

கருவிபட்ளட யிைிருந்து கதர்ந்மதடுக்கவும். சுட்டியின் வடிவம் 
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Crosshair குறியுடன் கீழ்ப்பகுதில் பைககாணம் மகாண்டு குறியாக 
இருக்கும். 

2. இப்கபாது வளையும் பகுதியில் எங்கு ஐங்ககாணம் வளைய 

கவண்டுகொ அங்கு சுட்டியின் இடது மபாத்தாளன அழுத்தி 
பிடித்தவாறு நகர்த்த கவண் டும். 

3. நாம் விரும்பும் வடிவமுளட ய பைககா ணம் உருவானவுடன் 

சுட்டியின் மபாத்தாளன அழுத்துவளத விட்டு விடவும். 

4. வளைந்த பைககா ணத்தின் பக்க ங்களள அதிகரிக்க நாம் 
வளைந்த பைககாணத்ளத pick கருவி மூைம் கத ந்மதடுக்கவும். 

5. சுட்டிளய பண்புபட்ளடயில் உள்ள Number of Points on Polygon 

உளைப்மபட்டியில் கிளிக்மசய்து கதளவயான பக்கங்களின் 

எண்ணிக்ளகளய மகாடுக்கவும். 

3. Corel Draw வில் எவ்வொறு ஒரு நட்ெத் ிைத்ம  உருவொக்குவொய்? 

நட்ெத்  ிைம் வமை ல் 

polygon கருவியின் கீழ்ப்ப குதியில் சிறிய அம்புக்குறி உள்ளது. 

இந்த அம்புகுறி flyout.உள்ளளத உணர்த்துகிறது நட்சத் திைம் 

வளைய 

1. பைககாண கருவியின் ெீது அழுத்திக்மகாண்கட இருந்தால் flyout 

பட்டிகதான்றி கெலும் பை கருவிகளள காட்டும். 

2. flyout பட் டியில் உள்ள நட்சத்திைக்கருவிளய கிளிக் மசய்யவும். 

3. வளையும் பகுதியில் எங்கு நட்சத்திைம் வைகவண்டுகொ அங்கு 

சுட்டியின் இடது மபாத்தாளன அழுத்தி பிடித்தவாறு இழுத்து 

நகர்த்தவும் 

4. நட்சத்திை உருவம் உருவானவுடன் சுட்டியின் மபாத்தாளன     

 அழுத்துவளத விட்டு விடவும். 

4. கட்டங்கமள (Grid) வமைய படிநிமைகமள எழுதுக. 

கட்ட ங்கள் வமை ல் 

Graph Paper கருவிளய பயன்படுத்தி நாம் குறிப்பிட்ட எண்ணிக்ளக 

வரிளச ெற்றும் மநடுவரிளச களள மகாண்ட ஒரு கட்டகம் 

வளையைாம். கட்டகம் என்பது தனித்தனியாக பிரிக்கக் கூடிய பை 

மசவ்வகங்கள் கசர்ந்த அளெப்பாகும். 

ஒரு கட்டகம் வளைய 

1. பைககா ண கருவியின் ெீது அழுத்திக் மகாண்கட இருந்தால் 

flyout பட் டி கதான்றி கெலும் பை கருவிகளள காட்டும். 

2. flyout பட் டியில் உள்ள Graph Paper கருவிளய கிளிக் மசய்யவும். 

3. பண்புபட்ளடயில் உள்ள கெல் ெற்றும் கீழ்ப்பகுதியில் 

மநடுவரிளச ெற்றும் வரிளச களின் எண்ணிக்ளகளய 
உள்ளிடவும். 
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கெல் பகுதியில் உள்ளிடப்படும் ெதிப்பு மநடுவரிளச 

எண்ணிக்ளகளயயும் கீழ்ப்பகுதியில் உள்ளிடப்படும் ெதிப்பு 

வரிளச 

எண்ணிக்ளகளயயும் குறிக்கும். 

4. வளையும் பகுதியில் எங்கு கட்டகம் கதான்ற கவண்டுகொ 

அங்கு கிளிக்மசய்யவும். 

5. சுட்டிளய கிளடெட்டொக இழுப்பதன் மூைம் கவண்டிய 

கட்டகம் வளைய முடியும். 

6. ளெயப் புள்ளியிைிருந்து மவளிப்புறொக கட்டங்கள் வளைய 

shift விளசளய விளசளய அழுத்தியவாறு நகர்த்த கவண்டும். 

கட்டங்களள சதுை வடிவல் அளெக்க Ctrl விளசளய விளசளய 

அழுத்தியவாறு நகர்த்த கவண் டும். 

5. பொம யில் உமையிமனதபொருத்து ல் பற்றி விரிவொக எழுது. 

எந்த வடிவ பாளதயிலும் உளை சைத்ளத மபாருத்த Corel Draw 

அனுெதிக்கின்றது. அது கநர் அல்ைது வளளந்த ககாடு, ஒரு 
மசவ்வகம், ஒரு நீள்வட்டம் அல்ைது ெற்மறாரு எழுத்து அல்ைது 

உளை சைம் என பைவடிவ பாளதகளாக இருக்கைாம். உளையிளன 
பாளதயில் மபாருத்துவதற்கு Text பட்டியிைிருந்து Fit text to path 

கட்டளளயிளன பயன்படுத்தவும் 
உளையிளன பாளத யில் மபா ருத்துதல் 

1. Pick கருவி ெற்றும் Shift சாவி மகாண்டு உளை மபாருளளயும் 

ெற்றும் இைண்டாவது மபாருளளயும் கதர்வு மசய்யவும். 

2. Text பட் டியிைிருந்து Fit + Text to path என்பளத கதர்வு மசய்யவும். 

3. இைண்டாவது மபாருளின் பாளதயின் வைி உளையானது 

ெீண்டும் 

வளையப்படுகின்றது 

பொடம் 4  
பல்லூடகம் ேற்றும் கணிப்தபொறிப் ப ிப்பகம் 

பகு ி – அ 

I. சரியான விளடளயத் கதர்ந்மதடுத்து எழுதுக 

1. _________ என்பத ஒன்றிற்கு கெற்ப ட்ட ஊடக வளக யான உளை, 

tளைகளை,ஒளிக்காட்சி, அளசவூட்டல் ெற்றும் ஒைி ஆகியவற்றில் 

ஏகத னும் ஒரு வளகப்பயன்பாட்ளடக் குறிக்கும். 

இ) பல்லூடகம்  

2. பல்லூடகத்தின் குளறபாடுகளில் ஒன்று அதனுளடய _________ 

அ) விளை  

3. விரிவாக்கம் JPEG ஆ) Joint Photographic experts group 

4. பல்லூடகத்ளத உருவாக்க நெக்கு கதளவயானளவ வன்மபாருள், 

மென்மபாருள் ெற்றும் _________ 
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ஈ) நிைைாக்க திறன் 

5. சரியான ஒன்ளறத் கதர்ந்மதடுத்து பின்வருவனவற்ளற மபாருத்துக. 

1. உளை - TGA 

2. நிைற்படம் - MIDI 

3. ஒைி - MPEG 

4. ஒளி - RTF 

இ) 4, 1, 2, 3  

6. பின்வருவனவற்றில் மபாருந்தாத ஒன்ளறக் கண்டுபிடிக்கவும். 

இ) RTF  

7. _________ என்பது அளசயா நிைற்படங்களள மதாடர்ச்சியான 

இயக்கொக காட்சிப்படுத்தும் மசயல். 

ஈ) அளச வூட்டல் 

8. இளணயத்தின் மூைம் நிகழ்கநை நிகழ்ச்சிகளள கநைடியாக 

ஒளிப்பைப்புவளத _________ என்கிகறாம். 

அ) வளை ஒளிப்பைப்பு 

9. GIF பயன்படுத்தும் வண்ண கதடல் அட்டவளண _________ 

அ) 8 பிட் 

10. RTF ககாப்பு வடிவத்ளத அறிமுகப்படுத்தியது _________ 

ஆ) Micorsoft 

பகு ி – ஆ 

II. மூன்று வரிகளில் விளடயளிக்கவும் 
1. வளையறு – பல்லூடகம் ெற்றும் அதன் சிறப்பம்சம். 

பல்கவறு வளங்களான நிைற்படம், உளை, வளைகளை, 

ஒளிக்காட்சி, ஒைி ெற்றும் ஒளி ஆகியவற்ளற ஒன்றிளணத்து, 

தைவுகளள ஒற்ளறத்தளத் திற்கு ொற்ற பயனர்களுக்கு 

பல்லூடகம் அனுெதி அளிக்கிறது. 

2. பல்லூடக கூறுகளளப் பட்டியைிடுக. 

பல்லூடகம் 5 முக்கிய கூறுகளளக் மகாண்டுள்ளது. அளவ உளை, 

நிைற்படம், ஒைி, ஒளிக்காட்சி ெற்றும் அளசவூட்டல். 

3. பல்லூடகத்தில் உளை (Text)கூறிளன வளகப்படுத்துக. 

நிமையொன உமை (Static text) 

ஒரு தளைப்பிகைா அல்ைது ஒரு வரியிகைா அல்ைது ஒரு 

பத்தியிகைா , உளை அல்ைது மசால் ொறாெல் இருந்தால் அது 

நிளையான உளை ஆகும். 

ேீ உமை (hypertext) 

ெீவுளை என்பது முளன யம், உளை ெற்றும் 

முளனங்களுக்கிளடகய யான இளணப்பு ஆகியவற்ளறக் 
மகாண்டிருக்கும் அளெப்பாகும். 
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4. பல்லூடகத்தில் நிைற்படகூறிளன வளகப்படுத்துக 
பிட்டேப் அல்ைது தெவ்வக படங்கள் (Bit mapor Raster image) 

கணினியில் படங்களளச் கசெிக்கும் மபா துவான ெற்றும் பைந்த 

வடிவம் பிட்கெப் அல்ை து மசவ்வக படொகும். பிட்கெப் என்பது 
படப்புள்ளி (pixel) என்றளைக்கப்ப டும் சிறிய புள்ளிகளின் எளிய 

அணியாகும் 
தவக்டர் படங்கள் (Vector images) 

வளையும் கூறுகளான அல்ைது மபாருள்களான வரிகள், 

மசவ்வகங்கள், வட்டங்கள் ெற்றும் பை 

படங்களளஉருவாக்குவது மவக்டர்படங்களின் அடிப்பளடயில் 

அளெயும். 

5. வளையறு – அளசவூட்டல் ெற்றும் அதன் சிறப்பம்சம். 

அளசயா படங்களள (Still images) ெிக விளைவாக காண்பிப்பதன் 

மூைம் அவற்ளற மதா டர்ச்சியான அளசவு கபான்ற உணர்ளவ 

மகாடுக்கும் மசயகைஅளசவூட்டல் ஆகும். அளசவூட்டைில், 

திளைமபாருள் என்பது ஒரு மவக்டர் படொகும். எண் 

ொற்றத்ளதப் பயன்படுத்தி ஒருங்கிளணப்புகளள (Coordinates) 

வளையறுக்க படத்துடன் அதன் பாளதயின் இயக்கம் 

கணக்கிடப்ப டும். இைண்டு வளகயானஅளசவூட்டல்களாவன: 

பாளத அளச வூட்டல் (path animation) ெற்றும் சட்டகம் அளசவூட்டல் 

(Frame animation). 

6. நிைற்பட ககாப்பு வடிவங்களளப் பட்டியைிடுக. 

1. TIFF(Tagged Image File Format) 2. BMP(Bitmap) 3. DIB(Device IndependentBitmap) 
4. GIF(Graphics Interchange Format) 5. JPEG(Joint Photographic Experts Group) 6. 
TGA(Tagra) 7. PNG(Portable Network Graphics) 

7. ஒைி ககாப்பு வடிவங்களளப் பட்டியைிடுக. 

1. WAV(Waveform Audio File Format) 2. MP3(MPEG layer-3 Format) 3. OGG 4. 
AIFF(Audio Interchange File Format) 5. WMA(Windows Media Audio) 6. RA(Real 
Audio Format)  

8. ஒளிக்காட்சி ககாப்பு வடிவங்களளப் பட்டியைிடுக. 

1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)  

9. வளையறு – பல்லூடக உருவாக்கம். 

பல்லூடகத்ளத உருவாக்குவதற்கு கபாதுொன கநைம் ெற்றும் 

திறளெ யான திட்டெிடல் ஆகியளவ கதளவப்படுகின்றன. இது 

திட்டப்பணி சுமூகொக மதாடைவும் ெற்றும் தகவல் இைக்கு 

பார்ளவ யாளர்களளச் மசன்றளடயவும் உறுதிமசய்கிறது. 

10. பல்லூடக உருவாக்க குழு உறுப்பினர்களள பட்டியைிடுக. 

1. தயாரிப்பு கெைாளர் 2. மபாருளடக்க வல்லுநர் 3. ஸ்கிரிப்ட் 
எழுத்தாளர் 4. உளை பதிப்பாளர் 5. பல்லூடக 
வடிவளெப்பாளர் 6. கணினி வளைகளை களைஞர் 7. ஒைி 
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ெற்றும் ஒளிக்காட்சி வல்லுநர் 8. கணினி நிைைர் 9. வளை 
வல்லுநர் 

பகுதி-இ 
1. பல்லூடக கூறுகளள சுருக்கொக விவரி. 

பல்லூடகம் உளை, நிைற்படம், ஒைி,ஒளி ெற்றும் அளசவூட்டல் 

ஆகிய ஐந்துமுக்கியக் கூறுகளளக் மகாண்டுள்ள து. 

Dynamic Elements:Video,Animation,Audio 
Static Elements:Text,Graphics 

2. அளசவூட்டைின் சிறப்பம்சங்கள் ெற்றும் மதாைில் 
நுட்பங்களள விவரிக்கவும். 
அளசயா படங்களள (Still images) ெிக விளைவாக காண்பிப்பதன் 

மூைம் அவற்ளற மதா டர்ச்சியான அளசவு கபான்ற உணர்ளவ 

மகாடுக்கும் மசயகைஅளசவூட்டல் ஆகும். 

அளசவூட்டைில்,திளைமபாருள் என்பது ஒரு மவக்டர் படொகும். 

எண் ொற்றத்ளதப் பயன்படுத்தி ஒருங்கிளணப்புகளள 

(Coordinates) வளையறுக்க படத்துடன் அதன் பாளதயின் இயக்கம் 

கணக்கிடப்ப டும். இைண்டு வளக யானஅளசவூட்டல்களாவன: 

பாளத அளச வூட்டல் (path animation) ெற்றும் சட்டகம் அளசவூட்டல் 

(Frame animation). 

3. உருவாக்க குழு உறுப்பினர்களின் பணிகள் ெற்றும் 
மபாறுப்புகளளப் பற்றி எழுதுக. 

பல்லூடக உருவாக்கத் தில் அதிகபட்சபைளன உயர்தை 

திறளெயுடன் மபறும்வளகயில் குழு 

உறுப்பினர்களளகெைாண்ளெ மசய்வ து கட்டா யொகும்.நல்ை 

தைொன உயர்ந்த பல்லூடக உருவாக்க பயன்பாட்டிற்கு 

பின்வரும்உறுப்பினர்களளக் மகாண்ட வல்லுநர்குழு 

கதளவப்படுகிறது 
1. தயாரிப்பு கெைாளர் 2. மபாருளடக்க வல்லுநர் 3. ஸ்கிரிப்ட் 

எழுத்தாளர் 4. உளை பதிப்பாளர் 5. பல்லூடக 
வடிவளெப்பாளர் 6. கணினி வளைகளை களைஞர் 7. ஒைி 
ெற்றும் ஒளிக்காட்சி வல்லுநர் 8. கணினி நிைைர் 9. வளை 
வல்லுநர் 

4. பல்லூடகத்தில் உள்ள பல்கவறு ககாப்பு வடிவங்கள் பற்றி 
விவரிக்கவும். 
உளை வடிவங்கள் 
1.RTF(Rich Text Format) 2. Plain Text 
நிைற்பட வடிவங்கள் 
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1.TIFF(Tagged Image File Format) 2. BMP(Bitmap) 3. DIB(Device IndependentBitmap) 
4. GIF(Graphics Interchange Format) 5. JPEG(Joint Photographic Experts Group) 6. 
TGA(Tagra) 7. PNG(Portable Network Graphics) 

இைக்க ஒைி ககாப்பு வடிவங்கள் 
1.WAV(Waveform Audio File Format) 2. MP3(MPEG layer-3 Format) 3. OGG 4. 
AIFF(Audio Interchange File Format) 5. WMA(Windows Media Audio) 6. RA(Real 
Audio Format)  

 இைக்க ஒளிக்காட்சி ககாப்பு வடிவங்கள் 
 1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)  

பகுதி – ஈ 
ஒரு பக்க அளவில் விளடயளிக்கவும் 

1. பல்லூடக மசயல்கள் பற்றி விரிவாக விளக்கவும். 
பல்லூடகத்ளத உருவாக்குவதற்கு கபாதுொன கநைம் ெற்றும் 
திறளெயான திட்டெிடல் ஆகியளவ கதளவப்படுகின்றன. இது 

திட்டப்பணி சுமூகொக மதாடைவும் ெற்றும் தகவல் இைக்கு 

பார்ளவயாளர்களளச் மசன்றளடயவும் உறுதி 
மசய்கிறது.சிக்கைான பல்லூடக திட்டங்களள 
உருவாக்குவதற்கான படிநிளைகள் பின்வருொறு. 1.கருத்துரு 
பகுப்பாய்வு ெற்றும் திட்டெிடல் 2. திட்ட வடிவளெப்பு 3. முன்-
உருவாக்குதல் 4. வைவு-மசைவு திட்டெிட்ல் 5. பல்லூடகத்ளத 
உருவாக்கும் குழு 6. வன்மபாருள்/மென்மபாருள் 
கதர்ந்கதடுத்தல் 7. மபாருளடக்கத்ளத வளையறுத்தல் 8. 
கட்டளெப்ளப தயார் மசய்தல் 9. உருவாக்குதல் 10. கசாதித்தல் 
11. ஆவணப்படுத்துதல் 12. பல்லூடக திட்டத்ளத வைங்குதல் 

2. அளசவூட்டல் நுட்பங்கள் பற்றி விரிவாக விவரிக்கவும். 
அளசயா படங்களள (Still images) ெிக விளைவாக காண்பிப்பதன் 

மூைம் அவற்ளற மதா டர்ச்சியான அளசவு கபான்ற உணர்ளவ 

மகாடுக்கும் மசயகைஅளசவூட்டல் ஆகும். அளசவூட்டைில், 

திளைமபாருள் என்பது ஒரு மவக்டர் படொகும். எண் 

ொற்றத்ளதப் பயன்படுத்தி ஒருங்கிளணப்புகளள (Coordinates) 

வளையறுக்க படத்துடன் அதன் பாளதயின் இயக்கம் 

கணக்கிடப்ப டும். 
குளறந்தபட்ச சட்டக விகிதம் (Framerate) 16 சட்டங்கள் விநாடி என 

இருந்தா ல்மெ ன்ளெ யான கதாற்ற த்ளத க் மகா 

டுக்கும்.இயற்ளக கதாற்றத் திற்கு குளறந்தபட்சம் விநாடிக்கு 25 

சட்டகங்களாக இரு அல்ைது முப்பரிொணங்களளக் மகாண்ட து. 

திளையில் X ெற்றும் Y 

அச்சுகளுக்கிளடகயயான பைப்பில் இருபரிொண அளசவூட்டல் 

நிைற்படத்ளத உயிகைாட்டொக மகாண்டு வருகிறது. முப்ப 

ரிொண அளசவூட்டத் தில் X, Y ெற்றும் Z ஆகிய மூன்று 
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அச்சுகளுக்கிளடகய உயிகைாட்டம் நளடமபறுகிறது. இைண்டு 
வளகயான அளசவூட்டல்களாவன 
பொம  அமெ வூட்டல் 

ொறாத பின்னணிளயக் மகாண்ட திளையில் ஒரு மபாருளள 

நகர்த்துவளத உள்ளடக்கியது பாளத அளசவூட்டல் ஆகும். 

ெட்டக அமெ வூட்டல் 

இந்த அளசவூட்டைில், பை மபாருட்கள் ஒகை செயத்தில் 

நகர்வதற்கு அனுெதிக்கிறது ெற்றும் பின்னணி அல்ைது 

மபாருள்களும் ொறுகிறது 
3.  அளசவூட்டல் திளைப்படதுளறயில் உள்ள வாய்ப்புகள் பற்றி 
கண்டறியவும். 

மபாழுதுகபாக்கு மதாைில் துளறயில் குறிப்பிடத்தக்க முன்கனற்றத் 

திற்கு பல்லூடக மதாைில்நுட்பம் முக்கிய காைணொகும். இந்த 
மதாைில் நுட்பொனது வாமனாைி, மதாளைக்காட்சி, ஆன்ளைன்  
விளளயாட்டு, கதளவப்படும் ஒளிக்காட்சி கபான்ற அளனத்து 
வளகயான மபாழுது கபாக்கு அம்சங்களில் கதளவப்படுகின்றது. 

கதளவப்படும் ஒளிக்காட்சி அல்ைது கதளவப்படும் திளைப்படத்ளத 

வடீுகளில் உள்ள மதாளைக்காட்சி மபட்டிக்கு தனிப்பட்ட முளறயில் 

வைங்குவது ஒரு கசளவயாகும். திளைப்படங்கள் ளெய 

கசளவயகத்தில் கசெிக்கப்பட்டு மதாடர்பு வளையளெப்பின் மூைம் 

அனுப்படுகின்றது. மதாடர்பு வளையளெப்பில் இளணக்கப்பட்டுள்ள 

மசட்-டாப் பாக்ஸ் (Set Top Box) ஆனது இைக்க தகவல்களள ஒப்புளெ 

தகவல்களாக ொற்றி மதாளைக்காட்சி மபட்டிக்கு உள்ளடீு 

மசய்கின்றது. 
4.பல்லூடக உருவாக்க குழுவின் பணிகள் ெற்றும் மபாறுப்புகள் 
விரிவாக  
பல்லூடக உருவாக்கத் தில் அதிகபட்சபைளன உயர்தை திறளெயுடன் 

மபறும் வளகயில் குழு உறுப்பினர்களள கெைாண்ளெ மசய்வது 

கட்டாயொகும். நல்ை தைொன உயர்ந்த பல்லூடக உருவாக்க 

பயன்பாட்டிற்கு பின்வரும் உறுப்பினர்களளக் மகாண்ட வல்லுநர் 
குழு கதளவப்படுகிறது. 

1.  யொரிப்பு டேைொளர் 

பல்லூடக உருவாக்குதைில், குறித்தகநைத்தில் முழு தைத்துடன் 

பல்லூடக 

திட்ட உருவாக்க த்ளத வளையறுப்பது ெற்றும் ஒருங்கிளணப்பது 

தயாரிப்பு கெைாளரின் பங்கு ஆகும். 

2. தபொருளடக்க வல்லுநர் 

மபாருளடக்க வல்லுநர் என்பவர் ஏற்கனகவ திட்டெிடப்பட்ட 

பயன்பாட் டின் மபாருளடகத்ளதப் பற்றிய அளனத்து ஆைாய்ச்சி 
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மசயல்பாடுகளளயும் மசய்வதற்கு மபாறுப்பானவர் ஆவார். 

3. ஸ்கிரிப்ட் எழுத் ொளர் 

ஒளிக்காட்சி ெற்றும் படச்சுருள் ஸ்கிரிப்ட்கள் மதாடர்ச்சியான 

வரிளச யிலுள்ள நிகழ்வுகளளக் குறிக்கும். ஸ்கிரிப்ட் எழுத்தாளர் 

கருத்துருக்களள முப்பரிொன சூைல்களில் காட்சிப்படுத்துகிறார். 

4. உமை ப ிப்பொளர் (Text Editor) 

பல்லூடக உருவாக்குதைின் மபாருளடக்கம் எப்மபாழுதும் 

தருக்க ரீதியான ஓட்டொக இருத்தல் கவண்டும். 

5. பல்லூடக வடிவமேப்பொளர் 

பல்லூடக வடிவளெப்பாளர் பல்லூடகத்தின் அளனத்து 

அடிப்பளடத் மதா குதிகளான வளைகளை, உளை, ஒைி, இளச , 

ஒளிக்காட்சி, புளகப்படம் ெற்றும் பளடப்பாக்க மென்மபாருளளப் 

பயன்படுத்தி அளசவூட்டல் கபான்றவற்ளற ஒருங்கிளணப்பார் . 

6. கணினி வமைகமைகமைஞர் 

நிைைின் வளைகளை கூறுகளான பின்னணி, புல்ைட்கள், 

மபாத்தான்கள், பாடப்பதிப்பாய்வு,3-D மபாருள்கள், அளசவூட்டல் 

ெற்றும் சின்னங்கள் ஆகியவற்ளறக் ளகயாளும் பங்கிளன கணினி 
வளைகளை களைஞர் வகிக்கிறார். 

7. ஒைி ேற்றும் ஒளிக்கொட்ெி வல்லுநர் 

எடுத்துளைத்தல் ெற்றும் கசெிக்கப்பட்ட ஒளிக்காட்சிகளளப் 

பல்லூடக நிகழ்த்துதைில் ளக யாளத்கதளவப்ப டுபவகை ஒைி ெற்றும் 

ஒளிக்காட்சி வல்லுநர் ஆவார். 

8. கணினி நிைைர் 

கணினி நிைைர் மபா ருத்தொனமொைியில் குறிமுளற அல்ைது 

ஸ்கிரிப்ட் வரிகளள எழுதுகிறார் 
9. வமை வல்லுநர் 

ஒரு இளணய வளைப்பக்கத்ளத உருவாக்கி அளத பைாெரிப்பது 

வளை வல்லுநரின் மபாறுப்பாகும் 
5. பல்லூடக ககாப்பில் உள்ள மவவ்கவறு ககாப்பு வடிவங்களள 

விவரிக்கவும். 

உளை வடிவங்கள் 
1.RTF(Rich Text Format) 2. Plain Text 
நிைற்பட வடிவங்கள் 

1.TIFF(Tagged Image File Format) 2. BMP(Bitmap) 3. DIB(Device IndependentBitmap) 
4. GIF(Graphics Interchange Format) 5. JPEG(Joint Photographic Experts Group) 6. 
TGA(Tagra) 7. PNG(Portable Network Graphics) 

இைக்க ஒைி ககாப்பு வடிவங்கள் 
1.WAV(Waveform Audio File Format) 2. MP3(MPEG layer-3 Format) 3. OGG 4. 
AIFF(Audio Interchange File Format) 5. WMA(Windows Media Audio) 6. RA(Real 
Audio Format)  
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 இைக்க ஒளிக்காட்சி ககாப்பு வடிவங்கள் 
 1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)  

 

பொடம் 5 

அடடொப் ஃப்ளொஷ் ப்தைொப்பஷனல் CS6 

பகு ி – அ 

I. ெரியொன விமடமயத் ட ர்ந்த டுத்து எழுதுக 

1. Adobe Flash நிைல் மூைம் நீங்கள் எதளன உருவாக்க முடியும்? 

ஈ) கெகை உள்ள அளனத்தும் 

2. Flash பணியிட ளெயத்தின் நடுவில் உள்ள மபரிய மவள்ளள மசவ்வக 

வடிவம் ---அ) கெளட 

3. ஒரு புதிய Flash ஆவணத்ளத எவ்வா று உருவாக்குவாய் ? 

இ) File → New 

4. மகாடாநிளை பணித்தளத்தின் நிறம் மவள்ளள . இளத ொற்ற 

---- கத ர்ந்மத டுக்கவும்.ஆ) Modify → Document 

5. Flash ககாப் புகள் ---- எனவும் அளைக்கப்படுகிறது.ஆ) Flash Movies 

6. கவனத்ளத ஈர்க்கும் வளக யிைான பதாளககளள (Banner) ---- மூைம் 

உருவாக்கைாம்.இ) Flash 

7. Flash ககாப்பின் மகாடாநிளை விரிவாக்கம் ---ஈ) .fla 

8. Flashல் நீங்கள் உருவாக்கும் எந்த உள்ளடக்கொயினும் அது --- என்று 

அளைக்கப்படுகிறது.ஈ) பயன்பா டு 

9. நீங்கள் துரிளகளய பயன்படுத்தி வளைவது கபான்று ககாடுளகள 

வளைய உதவும் கருவிஅ) Brush Tool  

10. கீழ்கண்ட எந்த கருவி, கருவிப் பைகத்தில் ஒகை குழுவில் 

இடம்மபறுகிறது. ஈ) PolyStar Tool 

11. Oval கருவிளய பயன்படுத்தி எவ்வாறு ஒரு வட்டத்ளத 

வளை யைாம் ? ஈ) Shift விளசளய அழுத்தி ளவத்துக் மகாண்கட . 

12. எந்த கருவி ஒரு வளைபடத்தின் குறிப்பிட்ட பகுதிளய மபரிதாக்கி 
காட்டும்.  இ) The Zoom tool 

II டகொ டிட்ட இடங்கமள நிைப்புக 

1. பணித்தளத்தில் -------- -- கருவிளய பயன்படுத்தி ஒருகநர்ககாட்ளட 

வளையைா ம். (Line Tool ளைன் கருவி) 
2. ஒரு வட்டம் வளைய Oval கருவிளய கிளிக்மசய்து ---- விளசளய 

அழுத்தி மகாண்கட நகர்த்தகவண் டும்.(Shift) 
3. நீங்கள் ---- கருவி மூைம் சதுைம் வளைய முடியும்.(Rectangle) 

4. சா தாைன அைிப்பான் கபான்று மபாருட்களள அைிப்பதற்கு 

----- உதவுகிறது(Eraser) 
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5. Flash ககாப்புகள் தானாககவ ---- விரிவுடன் உருவாகும்.(.fla) 

பகு ி – ஆ 

II. மூன்று வரிகளில் விமடயளிக்கவும் 

1. Flash என்பதுஎன்ன? 

Adobe Flash Professional CS6 அனிகெஷன்களள உருவாக்க பயன்படும் 

மென்மபாருள்.அடிப்பளட மபாருட்களள வளையவும் காட்சிகளள 

உருவாக்கவும் பயன்படுத்தக்கூடிய கருவிகள் உள்ளன . இது 

(Adobe) அகடாப் நிறுவனத்தால் உருவாக்கப்பட்டுள்ளது 

2. Adobe ProfessionalFlash CS6ஐ மதாடங்க கதளவயான படிநிளைகளள 

எழுதுக. 

அகடாப் ஃப்ளாஷ் ப்மைாப்பஷனல் CS6 ளய மதா டங்க start > All 

programs > Adobe Flash professional CS6 – ளய கதர்வு மசய்யவும். 

1. ஃப்ளாஷ்-ல் நீங்கள் வளைவதற்கு (அ) அளசவூட்டம் 

மசய்வதற்கு 

முன்பு முதைில் நீங்கள் ஒரு புதியஆவணத்ளத உருவாக்க 

கவண்டும். 

வைகவற்பு திளையிைிருந்கதா(welcome screen) (அ) திளையின் 

கெற்பகுதியில் உள்ள Fileபட்டியிைிருந்கதா ஒரு புதிய 
ஆவணத்ளத உருவாக்க முடியும். 

2. ஒரு புதிய ஆவணத்ளத File பட்டியிைிருந்து உருவாக்க file → 

New–ளய கதர்ந்மதடுத்தால் New Document உளையாடல் மபட்டி 

கதான்றும். அதில் General தத்தைின் கீழ் உள்ள ActionScript 3.0 –ளய 

கதர்ந்மதடுத்து OK மபாத்தாளன கிளிக்மசய்தால் ஒரு புதிய 

ஆவணம் உருவாகும். 

3. காைக்ககாட்டின் (Time line) ன் கதளவ என்ன? 

(Timeline) காைக்ககாடு என்ப து Flash-ன் ெிக முக்கியொன 

கூறுகளில் ஒன்றாகும்.இது கெளடக்கு கீகை அளெந்துள்ளது. 

இது ஒவ்மவாரு உறுப்பு கதாற்றத்ளதயும் அனிகெஷளனயும் 

குறிக்க பயன்படுத்தப்படுகிறது. 

III. ஒரு பத் ியளவில் விமடயளிக்கவும் 

1. கீழ்கண்ட மசயல்களள மசய்ய உதவும் கருவிகளள கூறுக. 

அ. ககாடு வளைதல் 
Line கருவி (N) 

இது கநர்ககாடுகளள வளை வதற்குப்பயன்படுகிறது. நீங்கள் 

மசங்குத்து, கிளடெட்ட ெற்றும் 450 மூளைவிட்ட ககாடுகளள 
வளைவதற்கு Shift விளசளய அழுத்திப்பிடிக்க கவண்டும். 

ஆ. தற்கபாக்கு உருவம் வளைதல் 
Pencil கருவி 
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இது தற்கபாக்காக (freehand) ககாடுகள் ெற்றும் வடிவங்களள வளையப் 

பயன்படுகிறது. மபன்சில் முளற (Mode)விருப்பத்தில் உள்ள பட்டி 

பின்வரும் கட்டளளகளள காட்டும். 

● Straighten -கநர்க்ககாட்டிளன வளைவதற்கு, 

● Smooth – வளள ககாட்டிளன வளைவதற்கு 

● Ink - அளவுககாைற்ற வளைபடங்களள எந்த ொற்றமும் இன்றி 
வளைய 

இ. நீங்கள் வளைந்தவற்ளற அைித்தல் 
Eraser கருவி (E) 

இது ககாடுகள் ெற்றும் உட்பைப்புகளள (Fill)அைிக்கப் பயன்படுகிறது 

2. Zoom கருவி ெற்றும் Hand கருவி கவறுபாடுகளளக் கூறுக. 

Zoom கருவி (Z) 

இது கெளடப்பகுதிளய மபரிதாக ொற்றப்பயன்ப டுகிறது. இது 

கெளடயில் ஒருபகுதியில் கிளிக் மசய்வதன் மூைம் அதளன 
மபரிதாக்கைாம். Alt விளசளய அழுத்திப்பிடித்து கெளடயில் கிளிக் 

மசய்தால் அதளன சிறிதாக்கைா ம். 

Hand கருவி (H) 

இது கெளடளய நகர்த்த பயன்படுகிறது.ஒட்டுபைளகயில் எங்கு 

கவண் டுொனாலும் பணித்தளத்ளத இழுத்து நகர்த்தைாம். 

IV. ஒரு பக்க அளவில் விமடயளிக்கவும் 

1. Flash சன்னல்திளையில் பயன்படுத்தும் கூறுகளள விவரி. 

ஃப்ளொஷ் ென்ன ல்  ிமை கூறுகள் (அ) பகு ிகள் 

ஃப்ளாஷ் சன்னல் திளை நான்கு பகுதிகளாக (அ) கூறுகளாக 

பிரிக்கப்பட்டுள்ள து.அளவ 

1. பணித்தளம் ெற்றும் ஒட்டுப்பைளக(Stage and paste Board) 

2. காைக்ககாடு (Timeline) 

3. கருவிகள் பைகம் (Tools Panel) 

4. பண்பு கசாதிப்பான் (Property Inspector) 

பணித் ளம் ேற்றும் ஒட்டுப்பைமக (பணிப்ப கு ி) (The Stage and 

Pasteboard (work area) 

உங்கள் பணித்தளத்தின் நடுவில்உள்ள மசவ்வக 

மவள்ளளப்பகுதி 
கெளட (Stage) என அளைக்கப்படுகிறது.அளசவுப் படத்திற்கான 

அளசவூட்டங்கள்,மபா ருட்கள் ெற்றும் காட்சிகள் ஆகியவற்ளற 

உருவாக்க, பதிப்பிக்க இருத்திளவக்க ெற்றும் இயக்க இந்த 

கெளட உதவுகிறது. 

கொைக்டகொடு (Time Line) 

காைக்ககாடு என்பது ஃப்ளாஷ்-ன் ெிகமுக்கியொன கூறுகளில் 

ஒன்றாகும்.இது பணித்தளப் பகுதியின் கீகை அளெந்துள்ளது. 

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Org

www.Padasalai.Net                             www.TrbTnpsc.com

Send Your Questions & Answer Keys to our email id - padasalai.net@gmail.com

www.Padasalai.Net


Padasalai

இது ஒவ்மவாரு உறுப்பின் கதாற்றத்ளதயும் ெற்றும் 
அளசவூட்டத்ளதயும் மதளிவாக காட்ட பயன்படுகிறது. 

ஃப்ளொஷ் கருவிகள் பைகம்(The Flash Tools Panel) 

ஃப்ளாஷ் கருவிகள் பைகம் நீங்கள் கெளடயில் வளைகளைளய 

உருவாக்க,கதர்ந்மதடுக்க (அ) பதிப்பிக்கத் கதளவயான 
கருவிகளள மகாண்டுள்ள து. 

பண்பு டெொ ிப்பொன்(Property inspector) 

இது மகாடாநிளையாக Flash பணியிடத்தின் வைது பக்கத்தில் 

கதான்றும். இது நூைகப்பைகத்துடன் இளணக்கப்பட் டிருக்கும். 

இது 

கதர்ந்மதடுக்கப்பட்ட மபாருளின் பண்புகள் ெற்றும் 

விருப்பங்களளக் காட்டுவகதாடு அவற்ளற ொற்றவும் 

அனுெதிக்கிறது. 

2. Tools பைகத்தில் காணப்படும் கருவிகள் சிைவற்ளற விவரி. 

Selection கருவி (V) 

இந்த கருவி ஒரு மபாருள் (அ) ஒரு மபாருளின் பகுதியாகிய 

மவளிக்ககாடு ெற்றும் உட்பைப்பு (Stroke & Fill) ஆகியவற்ளறத் 
கதர்ந்மதடுக்க பயன்படுகிறது. 

Free Transform கருவி (Q) 

இது மபாருள்களள சுைற்ற , அளவிட, வளளக்க ெற்றும் 

உருக்குளைக்க பயன்படுகிறது. 

3D Rotation கருவி (W) 

இது கெளடயில் முப்பரிொண மவளியில் சைனப்படத் 
துண்டுகுகளள (Movie Clips) சுைற்றுவதன் மூைம் முப்பரிொண 
விளளவுகளள உருவாக்க பயன்படுகிறது. 

Lasso கருவி (L) 

சாதாைணொக ஒரு மபாருளளச் சுற்றிவளைவதன் (Freehand) 

மூைம், இது 

மபாருள்களள கதர்ந்மதடுப்பதற்கு (அ) மபாருளின் ஒரு பகுதிளய 

கதர்ந்மதடுப்பதற்கு பயன்படுகிறது. 

Pen கருவி (P) 

இது நங்கூைப் புள்ளிகள் எனப்படும். மதாடர்புள்ளிகளள 

உருவாக்குவதன் மூைம்ககாடுகள் ெற்றும் வளளககாடுகளள 
வளைவதற்கு பயன்படுகிறது. 

Text கருவி (T) 

இது உளைளய உருவாக்க ெற்றும் பதிப்பிக்க பயன்படுகிறது. 

Line கருவி (N) 
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இது கநர்ககாடுகளள வளைவதற்குப் பயன்படுகிறது. நீங்கள் 

மசங்குத்து, கிளடெட்ட ெற்றும் 450 மூளைவிட்ட ககாடுகளள 
வளைவதற்கு Shift விளசளய அழுத்திப்பிடிக்க கவண்டும். 

Rectangle Tool (R) 

இது மசவ்வகம் வளையப் பயன்படுகிறது.Shift அழுத்திப்பிடிப்பதன் 

மூைம் சதுைம் வளையைா ம். 

3D Translation கருவி (G) 

இது கெளடயில் முப்பரிொண மவளியில் சைனப்படத் 
துண்டுகளள (Movie Clips)நகர்த்துவதன் மூைம் முப்பரிொண 
விளளவுகளள உருவாக்கப் பயன்படுகிறது 
Oval கருவி (O) 

இது நீள்வட்ட வடிவங்களள வளைவதற்கு பயன்படுகிறது. 

சரியான வட்டத்ளதவளை வதற்கு Shift விளசளய அழுத்திப்பிடிக்க 

கவண்டும் 
Poly Star கருவி 
இது பைககாணம் ெற்றும் நட்சத்திைங்களள 
வளையபயன்படுகிறது. மசவ்வகம், நீள்வட்டம், பிரிெிட்டிவ் 

மசவ்வகம் ெற்றும் Poly Star கருவிகள் எல்ைாம் ஒகை கருவியில் 
மதாகுக்கப்பட்டு கருவி பைகத்தில் உள்ளது. 

Pencil கருவி 
இது தற்கபாக்காக (freehand) ககாடுகள் ெற்றும் வடிவங்களள 

வளையப் 

பயன்ப டுகிறது. 

Brush கருவி (B) 

இது தூரிளககள் கபான்ற ககாடுகள் (Paint)வளைவதற்கு 

பயன்படுகிறது. 

Eraser கருவி (E) 

இது ககாடுகள் ெற்றும் உட்பைப்புகளள (Fill)அைிக்கப் 

பயன்படுகிறது. 

Hand கருவி (H) 

இது கெளடளய நகர்த்த பயன்படுகிறது.ஒட்டுபைளகயில் எங்கு 

கவண்டுொனாலும் பணித்தளத்ளத இழுத்து நகர்த்தைாம். 

Zoom கருவி (Z) 

இது கெளடப் பகுதிளய மபரிதாக ொற்றப்பயன்படுகிறது. இது 

கெளடயில் ஒருபகுதியில் கிளிக் மசய்வதன் மூைம் அதளன 
மபரிதாக்கைாம். Alt விளசளய அழுத்திப்பிடித்து கெளடயில் 

கிளிக் மசய்தால்அதளன சிறிதாக்கைா ம். 

Stroke Color கருவி 
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இது வளையப்பட்ட மபாருள்களின் மவளிக்ககாட்டின் நிறத்ளத 

ொற்றி அளெக்கப் பயன்படுகிறது. 

Fill Color கருவி 
இது வளையப்பட்ட மபாருள்களின் உட்பைப்பின் வண்ணத்ளத 

ொற்றப் பயன்படுகிறது. 
பொடம் 6 

ஆட்டடொடகட் 2016 
பகு ி – அ 

 

1. ஆட்கடாககட் என்பது _________மென்மபாருளாகும். 

ஆ) Computer-aided design (CAD) and drafting 

2. ஆட்கடாககட் 2016ஐ உருவாக்கி விற்பளன மசய்யும் நிறுவனம் 
________ 
இ) Autodesk, Inc. 

3. சிவப்பு நிற “A” மபாத்தாளனக் கிளிக் மசய்தால் கதான்றும் 

பட்டி_________ 

அ) Application  

4. பயன்பாட்டுப் பட்டியின் கெல்பகுதியில் கதான்றும் பட்ளட எது? 

ஆ) Search 

5. கட்டளளச்சாளைம் கதான்றவில்ளைமயனில் எந்த விளசப்பைளக 

குறுக்குவைிகளளப் பயன்படுத்த கவண்டும்? 

ஆ) Ctrl + 9 

6. UCS என்பது எதன் குறுக்கம்? அ) User Coordinate System 

7. கட்டங்களள (grid) காண்பிக்கவும், ெளறக்கவும் (ON or OFF) 

விளசப்பைளகயில் எந்த மசயல்பாட்டு விளசளய அழுத்த கவண்டும்? 

ஈ) F7 

பகு ி – ஆ 

1. ஆட்டடொடகமட எவ்வொறு த ொடங்குவொய் ? 

ஆட்கடாககட் 2016 ஐ மதாடங்க , திளைமுகப்பில் உள்ள Auto CAD 2016 

–English பணிக்குறிளய இருமுளற கிளிக்மசய்ய கவண்டும். 

(அல்ைது) Start > All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016 – English  

என்ற வரிளசயில் கிளிக் மசய்ய கவண்டும். 

2. ரிப்பனில் உள்ள அளனத்துப் மபாத்தான்களளயும் எப்படி 
ெளறப்பாய் ? 

1. முதல் முளறயாக சிறிதாக்குப் மபாத்தாளன கிளிக் மசய்யும் 

கபாது ரிப்பன் மதாகுதிகள் ெற்றும் கபனல் மபாத்தான்களுடன் 

காட்சியளிக்கும். 
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2. இைண்டாவது முளறயாக சிறிதாக்குப் மபாத்தாளன கிளிக் 

மசய்யும் கபாது, கபனல் மபாத்தான்கள் கபனல் தளைப்புகளாக 

ொறும் 

3. ரிப்பனில் உள்ள ஒரு மபாத்தான் ெீது சுட்டுக்குறிளய நிறுத்தும் 

கபாது 

என்ன கதான்றும்? 

முதல் முளறயாக சிறிதாக்குப் மபாத்தாளன கிளிக் மசய்யும் கபாது 

ரிப்பன் மதாகுதிகள் ெற்றும் கபனல் மபாத்தான்களுடன் 

காட்சியளிக்கும். இப்மபாழுது கபனல் மபாத்தானின் ெீது சுட்டிளய 

நகர்த்தினால் , அந்த கபனைில் உள்ள அளனத்துக் கருவிகளும் 

மதரியும் 

4. UCS பணிக்குறிளய எவ்வாறு நீக்குவாய் ? 

இருபரிொண வளைபடங்களுக்கு UCS பணிக்குறி 
கதளவப்படுவதில்ளை .அப்மபாழுது UCSICON கட்டளள மூைம் அளத 

நீக்கிவிடைாம். 

Command  : ucsicon 
Enter an option : off 

5. OSNAPஐ ON ெற்றும் OFF மசய்வதற்கு எந்த மசயல்பாட்டு விளசளயப் 

பயன்படுத்த கவண்டும்? 

F3 மசயல்பாட்டு விளசளயப் பயன்படுத்தி  OSNAPஐ ON ெற்றும் OFF 

மசய்யைாம் 

6. ளைன் (LINE) கட்டளளளயப் பயன்படுத்தும்கபாது பைககாணத்ளத 

முடிக்கப் பயன்படும் விளைவான வைிமுளறளய க் கூறு. 

 இைண்டு அல்ைது அதற்கு கெற்பட்டமதாடர்ச்சியான ககாடுகளள 

வளையும் கபாது, Close விருப்பொனது முதல்ககாட்டின் மதாடக்கப் 

புள்ளிளயயும், களடசி ககாட்டின் முடிவுப் புள்ளிளயயும் இளணக்கப் 

பயன்படுகிறது. 

7. ளைன் கட்டளள ெற்றும் மைக்டாங்கல் கட்டளளளயப் பயன்படுத்தி 
மசவ்வகம் வளையும்கபாது ஏற்படும் நளடமுளற சிக்கல்களளக் கூறு. 

ஏன் ஒன்ளற விட்டு ெற்மறான்ளற பயன்படுத்த கவண்டும்? 

ளைன் கட்டளளளயப் பயன்படுத்தியும் மசவ்வகம் 

வளையமுடியும். ஆனால் அதில் சிை குளறபாடுகள் உள்ளன. 

எடுத்துக்காட்டாக , ககாணஅளவுகள் 90 டிகிரி உள்ளனவா என 
சரிபார்க்க கவண்டும். கெலும் ஒவ்மவாருககாடும் தனித்தனி 
மபாருளாக இருக்கும்.ஒரு ககாட்டின் ெீது கிளிக் மசய்தால் அந்தககாடு 

ெட்டுகெ கதர்வு மசய்யப்படும். ெற்ற ககாடுகள் கதர்வு மசய்யப்படாது. 

ஆளகயால் ஆட்கடாககட் 2016இல் உள்ளRECTANG கட்டளள, சரியான 

ககாண அளவுகளுடன் ஒரு மசவ்வகத்ளத ஒகை மபாருளாக வளைய 

வைி வகுக்கிறது. 
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8. ஆட்கடாககடில் ஒரு கட்டளள மசயல்பாட்டில் இருக்கும்கபாது 

அதிைிருந்து எவ்வாறு மவளிகயறைாம்? 

ESC விளசளய எந்த கநைத்திலும் அழுத்த முடியும். ஒரு மசயல் 

மசயல்பாட்டில் இருக்கும்மபாழுது ESC விளசளய அழுத்தினால் , அது 

அக்கட்டளளளய முடிவுக்குக் மகாண்டு வரும். 

9. ஆர்க் ெற்றும் சர்க்கிள் மபாத்தான்கள் எந்த ரிப்பன் கன்ட்கைால் 

கபனைில்உள்ளன? 

Arc ெற்றும் Circle கருவிகள் அளனத்தும் ரிப்பனில் உள்ள Draw 

கபனைில் ஒரு குழுவாக இருக்கும். 

10. ERASE கட்டளளளய உள்ளிட்டபின், ஆட்கடாககட் உங்களள என்ன 

மசய்யச் மசால்கிறது? 

ஒரு மபா ருளள அைிக்க , 

1. Home tab > Modify pael > Erase toolஎன்பளத க் கிளிக் மசய் து ERASE 

கட்டளளளயத் கதர்ந்மதடுக்கவும்.(அல்ைது) கட்டளள வரியில் ERASE 

அல்ைது E என தட்டச்சு மசய்யவும். இப்மபாழுது மசருகும் புள்ளி 
crosshairைிருந்து சிறிய சதுைொக ொறியிருக்கும்.இது pickbox என்று 

அளைக்கப்படும்.இதன் கதாற்றம் திளையில் உள்ள ஒருமபாருளளத் 

கதர்ந்மதடுக்கத் தயாைாக உள்ளது என்பளதக் காட்டுகிறது. கெலும் 

கட்டளள வரியும் மபாருளளத் கதர்ந்மதடுக்கக் கூறும். 

11. இதுவளை கசெிக்காத ககாப்ளபமுதல் முளற யாக கசெிக்கும் 

மபாழுது, 

பயன்பாட்டுப் பட்டிப்பட்ளடயிைிருந்து Save அல்ைது Save As… என்பளதக் 

கிளிக் மசய்தால் என்ன கதான்றும்? 

ஆட்கடாககடில் நீங்க ள் மசய்த கவளைளயகசெிக்க , 

1. விளைவு அணுகல் கருவிப்பட்ளடயில்உள்ள Save மபா த்தாளனக் 

கிளிக் 

மசய்ய கவண்டும். 

2. வளைபடம் இதுவளைகசெிக்க ப்படவில்ளை எனில், SaveDrawing As 

உளையாடல் மபட்டிகதான்றும். 

3. அதில் File name உளைப்மபட்டியில் வளைபடத்திற்கான மபயளைக் 

மகாடுத்து Save மபா த்தாளனக் கிளிக் மசய்யவும். 

12. ஆட்கடாககடில் ஒரு ககாப்ளபதிறப்பதற்கான விளைவான வைி 
என்ன? 

சிவப்பு நிறத் தில் உள்ள பயன்பாட் டுப்மபா த்தாளன க் (A) கிளிக் 

மச ய்தால் ,பயன்பாட்டுப் பட் டி கதான்றும்.இந்த பட் டியானது, புதிய 

ககாப்ளப 

உருவாக்குதல் , ஏற்க னகவ உள்ள ககாப்ளபத் திறத்தல் , நடப்புக் 

ககாப்ளப கசெித்தல் , நடப்பு ககாப்ளப கவமறாரு மபயரில், கவறு 

ககாப்புளறயில் கசெித்தல் ,கவறு ககாப்பு வடிவத்தில் கசெித்தல் 
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,நடப்புக் ககாப்ளப அச்சிடுதல் கபான்ற ககாப்பு மதாடர்புளடய 

கட்டளளகளளக் மகாண்டிருக்கும். 

13. ஆட்கடாககடிைிருந்து எவ்வாறு மவளிகயறைா ம்? 

உங்கள் டவமைமய டெேித்து ஆட்டடொடகடிைிருந்து தவளிடயற , 

1. ஆட்கடாககட் சன்னல் திளையில்கெல் வைது மூளையிலுள்ள மூடு 

மபாத்தாளனக் (X) கிளிக் மசய்ய கவண்டும். 

2. திறந்திருக்கும் ககாப்புகளில் ஏகதனும் ொற்றம் 

மசய்யப்பட்டிருந்தால் ,ஆட்கடாககட் அளத கசெிக்க கவண்டுொ 
அல்ைது கசெிக்காெல் மூடகவண்டுொ என்பளத கீழ்க்கண்ட 

உளையாடல் மபட்டியில் உள்ளளதப் கபான்று வினா எழுப்பும். உங்கள் 

கவளைளய கசெிக்க Yes மபா த்தாளன க் கிளிக் மசய்ய கவண்டும். 

3. ஏற்கனகவ கசெிக்கப்படாத புதியவளைபடொக இருந்தால் , 

ஆட்கடாககட் Save Drawing As  என்னும் உளையாடல் மபட்டிளயத் 

திளையில்காட்டும். பின்னர் ககாப்ளப கசெித்துஆட்கடாககடிைிருந்து 

மவளிகயறும். 

பகு ி-இ 
1. மபாருள்களள உருவாக்குவதற்கான ஏகதனும் மூன்று 

கட்டளளகளளக் கூறு. 

• ளைன் கட்டளளளயக்(Line) மகாண்டு ககாடுகள் வளையைாம். 
• சர்க்கிள் கட்டளளளயப் (Circle)பயன்படுத்தி ஒரு வட்டம் வளைய 

முடியும் 
• RECTANG கட்டளள, சரியான ககாண அளவுகளுடன் ஒரு 

மசவ்வகத்ளத ஒகை மபாருளாக வளைய வைி வகுக்கிறது. 

2. விளசப்பைளக மூைம் LINE,CIRCLE ெற்றும் ERASE கபான்ற 
கட்டளளகளள எவ்வாறு விளைவாக உள்ளிடைாம்? 

• கட்டளள வரியில் LINE என தட்டச்சு மசய்ய கவண்டும். பின்னர் 
ஆைம்ப x ெற்றும் y ஆயத்மதாளைவுகளளக் மகாடுக்க 
கவண்டும். பின்னர் முடிவு ஆயத்மதாளைவுகளளக் மகாடுக்க 
கவண்டும். 

• கட்டளள வரியில் CIRCLE என தட்டச்சு மசய்து 
ளெயப்புள்ளிகளள (x ெற்றும் y ஆயத்மதாளைவுகளள) 
மகாடுக்க கவண்டும். பின்னர் D (Diameter) என தட்டச்சு மசய்து 
விட்டத்ளத உள்ளடீகவண்டும். 

• கட்டளள வரியில் ERASE அல்ைது E என தட்டச்சு மசய்யவும். 

அைிக்க கவண்டிய மபாருளின்ெீது pickboxஐ ளவத்து கிளிக் மசய்ய 

கவண்டும். மபாருளுளடய ககாட்டின் தடிென் மவ ளிர் சாம்பல் 
நிறத்திற்கு ொறும். அைிக்ககவண்டிய அளனத்துப் 
மபாருள்களளயும் மதாடர்ந்து கதர்ந்மதடுக்கைாம் நுளைவு 

விளசளய அழுத்த கவண்டும் 
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3. LINE கட்டளளயில் உள்ள Undo கதர்வின் பயன்களள எழுதுக. 

ஒரு ககாடு வளையும் கபாது முடிவுப் புள்ளிளயத் தவறாகக் 

குறிப்பிட்டுவிட்டால் , Undo கட்டளள மூைம்களடசியாகக் குறிப்பிட்ட 

புள்ளிளய நீக்கிவிட்டு, முந்ளதய கட்டத்திற்குச் மசல்ைைாம். இந்த 

விருப்பத்ளதப் பயன்படுத்த, கட்டளள வரியில் Undo அல்ைது U எனத் 

தட்டச்சு மசய்து நுளைவு விளசளய அழுத்த கவண்டும். 

4. வட்டங்களள உருவாக்கும் பின்வரும் முளறகளள சுருக்கொக 

விவரி. 

அ. Centre and radius 

• கட்டளள வரியில் CIRCLE என தட்டச்சு மசய்து நுளைவு 
மபாத்தாளன அழுத்தவும். பின்னர் கட்டளள வரியில் 
ளெயப்புள்ளிளய(x ெற்றும் y) குறிப்பிட்டு நுளைவு 
மபாத்தாளன ஆழுத்த கவண்டும். பின்னர் ஆைத்திளன 
உள்ளடீ்டு நுளைவு மபாத்தாளன அழுத்த கவண்டும் 

ஆ. Centre and diameter 

• கட்டளள வரியில் CIRCLE என தட்டச்சு மசய்து நுளைவு 
மபாத்தாளன அழுத்தவும். பின்னர் கட்டளள வரியில் 
ளெயப்புள்ளிளய(x ெற்றும் y) குறிப்பிட்டு நுளைவு 
மபாத்தாளன ஆழுத்த கவண்டும். பின்னர் கட்டளள வரியில் D 
என தட்டச்சு மசய்து நுளைவு மபாத்தாளன அழுத்த 
கவண்டும்.இப்கபாது விட்ட ெதிப்பிளன தட்டச்சு மசய்து 
நுளைவுப் மபாத்தாளன அழுத்த கவண்டும். 

பகு ி – ஈ 

1. ஆட்கடாககட் இளடமுகத்ளதப் பற்றி விவரி. 

ஆட்கடாககட்2016இன் இளடமுகொனது ரிப்பன்களளயும், 

பயன்பாட்டுப் பட்டிகளளயும் அடிப்பளடயாகக் மகாண்டது. இந்த 

இளடமுகத்தின் முக்கியொன அம்சம் வளைகளைப் பகுதியின் அளவு 

மபரியதாக இருக்கும். 

பயன்பொட்டுப் பட்டி (ApplicationMenu) 

சிவப்பு நிறத்தில் உள்ள பயன்பாட்டுப் மபாத்தாளனக் (A) கிளிக் 

மசய்தால் ,பயன்பாட்டுப் பட்டி கதான்றும்.இந்த பட்டியானது, புதிய 

ககாப்ளப 

உருவாக்குதல் , ஏற்கனகவ உள்ளககாப்ளபத் திறத்தல் , நடப்புக் 

ககாப்ளப 

கசெித்தல் , நடப்பு ககாப்ளப கவமறா ரு மபயரில், கவறு 

ககாப்புளறயில் கசெித்தல் ,கவறு ககாப்பு வடிவத்தில் கசெித்தல் 

,நடப்புக் ககாப்ளப அச்சிடுதல் கபான்ற ககாப்பு மதாடர்புளடய 

கட்டளளகளளக் மகாண்டிருக்கும். 

 பயன்பாட்டுப் பட்டியின் கெல் பகுதியில் கதடல் பட்ளட (Search bar) 
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இடம்மபற்றிருக்கும். 

 மைப்புப் பட்மட (Title bar) 

தளைப்புப் பட்ளடயானது Autodesk AutoCAD 2016 என்னும் மென்மபா ருளின் 

மபயளையும், தற்கபாளதய வளைபடத்தின் மபயளையும் 

மகாண்டிருக்கும். 

விமைவு அணுகல் கருவிப்பட்மட (Quick Access Toolbar) 

இந்த கருவிப்பட்ளட , சன்னல் திளையின் இடது கெல் ஓைத்தில் சிவப்பு 

நிற மபாத்தாளனஅடுத்துக் காணப்படும். இந்தப் பட்ளட Workspace 

ெற்றும் Undo/Redo கட்டளளகளுக்கும்,பயன்பாட்டுப் பட்ளடயில் உள்ள 

அளனத்து ககாப்புக் கட்டளளகளுக்கும் 

பணிக்குறிகளளக்மகாண்டிருக்கும் 
ரிப்பன் (Ribbon) 

ஆட்கடாககட் 2016 சன்னல் திளையின் கெல் பகுதியிலுள்ள தளைப்புப் 

பட்ளடக்கு கீகைஉள்ள பகுதி ரிப்பன் ஆகும். இந்த ரிப்பன் இைண்டு 

பகுதிகளள உளடயது. Ribbon Tab, Ribbon Panel 

Start த ொகு ி 
Start மதாகுதிளயக் கிளிக் மசய்தவுடன், ஆட்கடாககட் 2016 இன் 

மதாடக்கத் திளைெறுபடியும் கதான்றும். அதன் மூைம் புதிய 

வளைபடத்ளதத் மதாடங்குதல் , ஏற்கனகவ உள்ளவளைபடத்ளத 

திறத்தல் கபான்ற மசயல்களளச் மசய்யவும். 

File த ொகு ி 
ரிப்பனுக்கு கீகை File மதாகுதி பட்ளட உள்ள து. திறக்க ப்படும் 

ஒவ்மவாரு ககாப்பிற்கும்ஒரு மதாகுதி உருவாக்க ப்படும். File 

மதாகுதியின் ெைம் ஒரு வளைபடக் ககாப்பிைிருந்து ெற்மறாரு 

வளைபடக் ககாப்பிற்கு எளிதாக தாவிச் மசல்ை முடியும். 

வமைபடப் பகு ி 
திளையின் மப ருெளவுப் பகுதி வளைபடப் பகுதி (Drawing Area) ஆகும். 

இதில் 

மபாருள்களளயும், முப்பரிொண வளைகளைகளளயும் எளிதாக 

வளைய முடியும். 

கட்டமள ெொளைம் (Command Window) 

பயன்பாட்டு சாளைத்தின் அடிப்பகுதியில், நிளைளெப் பட்ளடக்கு (Status 

bar) கெைாக கட்டளள சாளைம் அளெந்திருக்கும். இந்தச் சாளைத்தில் 

மபாதுவாக மூன்று உளைவரிகள் காணப்படும். முதல் இைண்டு வரிகள், 

இதற்கு முன் பயன்படுத்திய கட்டளளகளளக் காட்டும் .களடசி 
வரியானது கட்டளள வரி ஆகும். கட்டளளச் சாளைம் கதான்றா 

விட்டால் Ctrl + 9என்னும் விளசகளள அழுத்தி கதான்றச் மசய்யைாம். 

ெேீபத் ிய உள்ளடீு (Recent input) 
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‘Command’: prompt இல் நாம் களடசியாக தட்டச்சு மச ய்த 20 

கட்டளளகளள, ஆட்கடாககட்நிளனவில் மகாண்டிருக்கும். இந்த 

கட்டளளகளுக்கு “Recent Input” என்று மபயர். 

UCS பணிக்குறி 
வளைபடப் பகுதியின் கீழ் இடது மூளையில்உள்ள L வடிவ ககாட்டிற்கு 

UCS பணிக்குறி என்று மபயர். UCS என்பது “User Coordinatesystem” என்பதன் 

குறுக்க ொகும். 

உைவு ல் பட்மட (Navigation Bar) 

உைவுதல் பட்ளடயானது வளைபடப்பகுதியில் இருக்கும். இது 

உைவுதலுக்கான கருவிகளளக் மகாண்டிருக்கும். 

நிமைமே ப் பட்மட (Status Bar) 

கட்டளள வரிக்கு கீகை நிளைளெப்பட்ட இருக்கும். சாளைத் தின் கீழ் 

வைது 

மூளையில் உள்ள பட்ளட பயன்பாட்டு நிளைளெப் பட்ளட (Application 

StatusBar) ஆகும். 

வமைபட ஆயத்த ொை ம வுகள் (Drawing Coordinates) 

ஆட்கடாககட் 2016 இல் டிைாயிங் ககாஆர்டிகனட் மபாத்தான் 

தானளெவாக 

ெளறக்கப்பட்டிருக்கும். கஸ்டளெகஷசன் பட்டிளயப் (Customization menu) 

பயன்படுத்திஅளதக் காண்பிக்க முடியும். 

ேொடல் (MODEL) 

வளைபடம் வளைவதற்காக ொடல்பகுதியில் பணிபுரியும் மபாழுது, 

ொடல் 

(MODEL) மபாத்தான் தானளெவாகத் கதர்ந்மதடுக்க ப்பட்டிருக்கும். 

பணித் ளம் (Workspace) 

பணித்தளம் என்பது வளைபடப் பகுதியின் இடம் ெற்றும் கதாற்றம், 

அளனத்து விதபட்டிகள், மபாத்தான்கள், மபாத்தான் மதாகுதிகள் 

அடங்கிய ஒரு முழுளெயான பயனர் இளடமுகம் ஆகும் 
2. கட்டளளச் சாளைம்  பற்றி விவரி. 

கட்டமள ெொளை ம் (Command Window) 

பயன்பாட்டு சாளைத்தின் அடிப்பகுதியில், நிளைளெப் பட்ளடக்கு 

(Status bar) கெைாக கட்டளள சாளைம் அளெந்திருக்கும். இந்தச் சாளைத் 

தில் மபாதுவாக மூன்று உளைவரிகள் காணப்படும். முதல் இைண்டு 

வரிகள், இதற்கு முன் பயன்படுத்திய கட்டளளகளளக் காட்டும்.களடசி 
வரியானது கட்டளள வரி ஆகும். கட்டளளச் சாளைம் கதான்றா 

விட்டால் Ctrl + 9 என்னும் விளசகளள அழுத்தி கதான்றச் மசய்யைாம். 

கட்டளள வரியில் மசருகும் புள்ளி உள்ள இடத்தில் கட்டளளகளள 

உள்ளிட முடியும். இது Command: prompt என அளைக்கப்படும். 
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கட்டளளயின் முதல் எழுத்ளத தட்டச்சு மசய்தவுடன், அந்த எழுத்தில் 

மதாடங்கும் அளனத்துக் கட்டளளகளின்  பட்டியல் கதான்றும். 

குறிப்பு 

கட்டளள வரியில் ெதிப்புகளள உள்ளிட்டவுடன் நுளைவு விளசளய 

அழுத்த கவண்டும். இந்தச் சாளைத்ளத கிளிக்மசய்து இழுத்து திளையில் 

எங்கு கவண்டுொனாலும் ளவக்கைா ம்.அளளவயும் ொற்றைாம். 

கட்டளளளய உள்ளிடும் கபாது சிறிய எழுத்திகைா, மபரிய எழுத்திகைா 

அல்ைது இைண்டும் கைந்கதா மகாடுக்க முடியும். கட்டளள வரியில் 

தட்டச்சு மசய்யும்மபாழுது பிளை ஏற்பட்டால் ,BACKSPACE விளச மூைம் 

அைித்துவிட்டு சரி மசய்யைாம். ESC விளசளய எந்த கநைத்தலும் அழுத்த 

முடியும். ஒரு மசயல் மசயல்பாட்டில் இருக்கும்மபாழுது ESC விளசளய 

அழுத்தினால் , அது அக்கட்டளளளய முடிவுக்குக் மகாண்டு வரும். 

ஆட்கடாககடில் முன்னதாகப் பயன்படுத்திய கட்டளளளயத் 

திரும்பவும் பயன்படுத்த கவண்டுமெனில், Command: prompt இல் நுளைவு 

விளச (ENTER) அல்ைது இளடமவளிவிளசளய (spacebar) அழுத்த 

கவண்டும். ொறாக சுட்டிளய வைது கிளிக் மசய்வதன் மூைம் 
கதான்றும் பட்டியில், Repeat என்னும் விருப்பத்ளத கதர்ந்மதடுக்கைாம். 

ெேீபத் ிய உள்ளடீு (Recent input) 

‘Command’: prompt இல் நாம் களடசியாக தட்டச்சு மசய்த 20 

கட்டளளகளள, ஆட்கடாககட்நிளனவில் மகாண்டிருக்கும். இந்த 

கட்டளளகளுக்கு “Recent Input” என்று மபயர். கட்டளளகளின் 

பட்டியளைக் காண விரும்பினால் சுட்டிளய வைது கிளிக் மசய்து 
வரும் பட்டியில் Recent input என்பளதக் கிளிக் மசய்ய கவண்டும். 

ஆட்கடாககட் இதற்கு முன் பயன்படுத்திய கட்டளளகளளயும், 

ஆயத்மதாளைவு உள்ளடீுகளளயும் (CoordinateInputs) துளணப்பட்டியைில் 

காட்டும். 

 

3. மைக்டாங்கல் மபாருளளப் பற்றி எழுதுக. ஆட்கடாககடில் மசவ்வகம் 

வளைவதற்கான வைிமுளறகளளக் கூறு. 

தெவ்வகம் வமை ல் 

வடிவளெப்பாளர்கள் பயன்படுத்தும் அடிப்பளட வடிவங்களில் 

ஒன்று மசவ்வகம் ஆகும். ளைன் கட்டளளளயப் பயன்படுத்தியும் 

மசவ்வகம் வளைய முடியும். ஆனால் அதில் சிை குளறபாடுகள் 

உள்ளன. எடுத்துக்காட்டாக , ககாண அளவுகள் 90 டிகிரி உள்ளனவா 

என 

சரிபார்க்க கவண்டும். கெலும் ஒவ்மவாரு ககாடும் தனித்தனி 
மபாருளாக இருக்கும். ஒரு ககாட்டின் ெீது கிளிக் மசய்தால் அந்த 
ககாடு ெட்டுகெ கதர்வு மசய்யப்படும். ெற்ற ககாடுகள் கதர்வு 

மசய்யப்படாது.ஆளகயால் ஆட்கடாககட் 2016இல் உள்ள RECTANG 
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கட்டளள, சரியான ககாண அளவுகளுடன் ஒரு மசவ்வகத்ளத ஒகை 
மபாருளாக வளைய வைி வகுக்கிறது. இந்த RECTANG கட்டளளளயப் 
பயன்படுத்தி வளையப்பட்ட மசவ்வகத்தின் எந்தமவாரு இடத்திலும் 

கிளிக் மசய்து முழு மசவ்வகத்ளதயும் கதர்ந்மதடுக்க முடியும். 

சுட்டுக்குறியின் மூைம் தெவ்வகத் ின் முமனகமளத் ட ர்ந்த டுத்து 

தெவ்வகம் வமை ல் 

1. Command: RECTANG (அல்ைது) REC(நுளை வு விளசளய அழுத்தவும்). 

2. கட்டளள வரியில் கீழ்க்கண்ட வாறு கதான்றும். 

RECTANGLE 
Specify first corner point or [Chamfer/ Elevation/Fillet/Thickness/Width]: 

மசவ்வகத் தின் முதல் முளன (P1) வளைய கவண்டிய இடத்திற்கு 

சுட்டுக்குறிளய நகர்த்தி சுட்டியின்இடது மபாத்தாளனக் கிளிக் 

மசய்யவும். 

3. கட்டளள வரியில் கீழ்க்கண்டவாறு கதான்றும். 

Specify other corner point or [Area / Dimensions / Rotatio]: 

மசவ்வகத்தின் முதல் முளனயிைிருந்து சுட்டிளய மூளைவிட்டம் 

வைியாக நகர்த்தி, ெறுமுளனயில் (P2) சுட்டியின் இடது மபாத்தாளனக் 

கிளிக் மசய்யவும். இப்மபாழுது மசவ்வகம் வளையப்பட்டிருக்கும். 
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